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Foreword

Most software these days comes with no printed 
documentation; just help files online. But for unskilled users 
getting to grips with an accounting system we think it much 
easier to have a book open next to the computer so you can 
refer to it and pencil notes in the margin.

So with ABC we have provided this User Manual on paper. It 
contains notes to get you started, and reminders for day to day 
operation. We have also supplied a vast amount of other stuff 
-- Reference Manual, Technical Notes, Training Guide, etc that 
installs onto your computer and is available on screen from 
within ABC. I hope this gives you the best of both worlds.

Chris Hicks 
chris@abc6.co.uk

(Do email me if you have any suggestions for improving this 
manual. I welcome feedback and criticism.)
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Copyright  
© 2007- 2015 
 
 

 
ABC Software retains sole copyright and title to 
these programs and documentation. All rights 
are reserved.  
 
You are granted a non-exclusive and non-
transferable licence to operate this software on a 
single computer for your own use.  
 
No distributor dealer or agent is authorised to 
change these terms.

Warning: Limited 
Liability

It is impossible for anyone to guarantee that 
a complex computer program is free of small 
faults (bugs). In addition the results produced 
by a program depend on the information entered 
at the keyboard; and the correct operation of the 
computer system. 
ABC Software and their agents and distributors 
can accept no liability for the use of this 
program or any direct or indirect consequential 
damages arising from the use of this program. 
It is the responsibility of the user of the program 
to check that this program is suitable for their 
requirements; that it is installed correctly; and 
that any results of its use are correct.

Credits Design supervisor: Chris Hicks.

Production details The ABC programs are mostly written in 
Microsoft Visual Basic. This Manual was 
prepared using Adobe InDesign.  
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FEEDBACK and 
Contact Details

We are keen to hear your comments, bug reports, 
complaints, and ideas for improvements  
(preferably by email).  
 
ABC Software  
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Warrington WA4 5NE,  UK  
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email:  feedback@abc6.co.uk  
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1
Introduction

An overview of ABC 
and how to use this manual

What ABC can do
ABC is a computer program designed to help take care of the bookkeeping 
and paperwork in a small business. Guessing you are not an accountant, we 
have made ABC very easy to use.

In technical terms ABC is an accounts package that can also print labels, 
letters and lists.  All the usual facilities are provided, including Sales 
Invoicing, Statements, Stock Control, VAT Returns, Cashbook, Profit & 
Loss Report, and Audit Trail. A Payroll module, Purchase Order Processing, 
Multi-user version ABC, and links to trade-specific software, are some of 
the optional extras available. We can also customise programs for you.

Computer Expert? or Beginner?
You may be new to computers and worried about which button to press. 
We have made the ABC program quite foolproof (though we know someone 
may invent a better fool). Everybody makes mistakes: it is easy to correct 
these later.  ABC contains lots of features that you may think you do not 
need; ignore those to start with.

After a while you will become a computer expert and want to go faster. ABC 
contains many hidden short cuts for you.

Boxes like this contain hints, 
shortcuts, efficiency tips and 
suggestions. 
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After-Sales Support
A Newsletter is sent out at irregular intervals, containing ideas and 
suggestions collected from other users of this package.

Technical advice is available by letter or email. If you have paid for Support 
you normally will get an immediate reply, otherwise it may take a little 
longer. 

After Sales Support can be purchased in periods of a month or a year. While 
your support is valid you have unlimited Telephone and email support, and 
free minor program updates (ABC can be set to automatically update itself). 
Your After Sales Support subscription can be viewed and renewed on our 
website, or you can pay by cheque or bank transfer.

An ABC User Forum (via our website -- page 106) allows you to discuss and 
comment on ABC with other users, and ask for help. This is free to use.

Independent consultants or ABC experts in various areas of the country 
provide after-sales support, training, telephone help lines, etc  for a small 
annual fee.

If you have paid a local company for After-Sales Support, write their 
telephone number and address in this box for quick reference:

Your computer
ABC should be happy to run on any computer that has Windows XP, 7, 8, or 
10 installed, and a few hundred megabytes of free disk space. Ideally your 
processor speed should be over 2GHz, and you will have at least 2GB of 
RAM. We strongly recommend you have some removable device for making 
backups (eg a USB stick).

Screen resolution ideally should be at least 1280x1024.

It should be possible to use any printer with ABC. If you need to use 
multi‑part ncr sets ABC has an option to print invoices and statements on 
dot‑matrix printers. -- page 116 
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How to use This Manual
This book is mainly a How to Guide briefly explaining day-to-day tasks, for 
example: how to produce a Sales Invoice.

General operation of the ABC program is hidden away towards the back 
of the book; and you’ll find pointers to suitable page numbers if  you need 
more explanation ..... eg.    page 123  

It is assumed that you have a working knowledge of the Windows Operating 
System (if not, go and spend 10 minutes learning how to  double-click 
a mouse, start and close a program, and drag the border of a window to 
change its size). 

You may have a fear of boring technical manuals but Please, PLEASE, 
glance through the first couple of Chapters of this book to get an overview 
of ABC and see important step-by-step instructions for getting started with 
Bookkeeping.

Find your way around
Use the Contents List (at the front) or Index (at the back of this manual) to 
lookup the pages you require.

Technical words are explained in a Glossary            page 117 

Using mouse and keyboard
If you have used Windows for more than a few minutes you probably 
already know these basic principles -- in which case you can look smug as 
you skim through this section.

The mouse moves the mouse cursor on the screen. When the mouse cursor 
is over the item you want to activate, click the left mouse button (ie. press 
and release it). 

To select some text, hold down the left mouse button as you move the 
mouse across the test -- this will highlight that section of text. Whatever 
text operation you choose now will be applied to the highlighted text only.  
Click the mouse anywhere else to cancel the selection.

You can usually change the size of windows, boxes and pictures on the 
screen by dragging their corners or sides. To do this, position the mouse 

Introduction     |       3



cursor over a corner or side of a box (the cursor will change shape to 
indicate the box is ready to be dragged). Then hold down the left mouse 
button and move the mouse to change the shape.

The right mouse button often produces a small popup menu of functions 
relevant to the item under the mouse cursor.

If your mouse has a wheel, this can be used for scrolling up and down.

While editing text, a text cursor will show your position in the text. The 
cursor keys can be used to move this around (or you can point to a new 
position with the mouse cursor and then left click the mouse to bring the 
text cursor to that position).

press ESC means press the ESC key on the keyboard

click OK means move the mouse cursor to the OK 
Button on screen, and click the left mouse 
button on it.

Enter FORMAT means type the word format, then press 
the ENTER key

Double Click press the left mouse button twice 
(quickly)

Hot Keys
Not everyone likes using the mouse all the time and it is possible to operate 
ABC most of the time using only the keyboard. This is faster and easier 
when entering items into bookkeeping but there are times when the mouse 
is useful.

To indicate to Windows that you are typing a special command, and not just 
another bit of text, you must press one of the command keys at the same 
time; usually the CTRL key or the ALT key. Possibly the most widely used 
keyboard shortcut is CTRL+C to Copy. (hold down the CTRL Key, and then 
also press the c Key)

Most buttons and menus can be operated by pressing the ALT key together 
with a letter of the alphabet. Look at the Menu or button: if one of the 
letters is underlined, that is the one that will activate it. For example, the 
File Menu can be activated by pressing ALT+F.
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Here are some useful keyboard shortcuts (hot keys)

CTRL+C Copy the selected item to the clipboard 
(eg. the highlighted section of text)

CTRL+V Paste the item from the clipboard at the 
cursor position

F1 Press the F1 key for HELP

ESC Press the ESC key to cancel or exit the 
operation.

F5 old ABC users are used to pressing F5 to 
Save (or Finish) the operation, so this still 
works in ABC6.

Close a window (exit)
The standard way to close a window (ie. finish with this operation) is to 
click the “X” at the top right hand corner of the window or tab.

However, sometimes ABC will not let you exit in this way. You might have 
begun entering an invoice. If you click the “X”, ABC needs to know if you 
want to cancel (discard) this work, or save it part finished; so before you 
can exit you need to click Save or Cancel.

This Manual is a rough guide
The user interface of ABC may change as we continue to work on the 
programs. And you can customise the appearance of many parts of ABC 
and Windows. This means that your screen might look different to the 
pictures in this Manual.

For this reason we have not shown many screenshots and have generally 
just pointed you in the right direction rather than giving exact step-by-step 
instructions. Hopefully this keeps the Manual thin, and avoids it going 
rapidly out of date.
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How to drive ABC
You can use the keyboard and the mouse to operate ABC. In most cases 
either can be used, and there are often several ways to do something  -- use 
whichever you find easiest.  

The Main Menu
Just about everything in ABC can be reached from the Main Menu (pictured 
below).To display the Menu click the large round button top left of the 
screen (or press ALT+M).

Use the mouse or cursor keys to move around the Menu.  Double-click the 
mouse or press the ENTER key to select a Menu item.

At the top left of the screen is a Quick Access Toolbar, and you can 
customise this to add any functions you use regularly. (To do this, right-
click on a menu option and select Add To Quick Access Toolbar.)

Don’t worry about accidentally selecting the wrong thing.  ABC will make 
you confirm things like Delete this Account.  If in doubt, select CANCEL or 
press ESC (the ESCAPE key). 
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On screen HELP
ABC includes an on-screen Manual that you can view at any time:   press 
the F1 key, or click a Help button, or select Help from a menu.

The on-screen Manual contains several Sections, including an Introduction, 
Reference Section, Beginner’s Guide and Operator Notes. Each Section 
contains several Chapters. An example is shown below. 

Help Pages contain links to other Help Pages: click on the underlined words 
to follow the link (and then click BACK if you want to get back to the 
previous page).

You can search the on-screen Manual by choosing Index or use Find to see 
all Pages containing the word(s) you are interested in.

While you are using ABC, if you request Help (press F1 or click Help) the 
program will usually be able to open the on-screen Manual at a relevant 
page (this is known as context sensitive Help).

The Help System remembers Pages you looked at recently, and you can use 
the Back and Forward keys to step through these Pages.
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Starting up ABC
From Windows desktop click on the ABC icon

If the Password system is turned off, the Main Menu will appear. Otherwise 
you need to Log-On by entering your Password.

Log In to ABC
Enter your own password.

To set up or edit Passwords (page 79)  
ABC may ask for your Registration Key (page 106) 
 
The Noticeboard may appear; you can Continue, or Edit the 
messages. The NOTICEBOARD is a useful place to leave 
notes for the next person to use ABC.  
You can turn it off  (page 99)

Close down ABC
Never switch off the computer without first closing down ABC. 

Click the “X” (top right of Window) or select EXIT from bottom bar of Main 
Menu. Closing ABC ensures files are closed and all information has been 
written safely to disk. 

Log Out of ABC
If you are just leaving the computer for a few minutes, you can Log Out 
(click the hand icon on Quick Access toolbar, or from Bottom bar of Main 
Menu). This stops anyone else playing with ABC while you are away 
(assuming you have Passwords turned On).

Change to different Company
If you have more than one set of accounts set up in ABC, to change to a 
different Company just Log Out, and then select the other Company.
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Customise your ABC
Many parts of ABC can be changed to suit your own preferences, including 
screen colours, screen layout, passwords, report content and quick access 
Menus. The OPTIONS MENU (top right of the screen) has some of these 
functions.

Buttons at the bottom right of the screen will change the screen layout from 
multiple windows side-by-side, to having them one above another.

To add a function to the Quick Access toolbar (top left of screen) right 
click on an item on the Main Menu and select ADD TO QUICK ACCESS 
TOOLBAR. 

Set your company details
You need to set your company name and other details before starting to use 
ABC for your real accounts.   Page 18 and 77 

Bottom left of the screen always shows the current bookkeeping month and 
accounts year start. If you use ABC for more than one company’s books the 
current company name is displayed near the top left of the screen.

Other functions of ABC
ABC is unusual amongst Accounts packages because it also lets you write 
letters, produce labels, design your own reports, produce spreadsheets, etc. 
These are lightweight functions for simple tasks only. (If you also use MS 
Office you can probably ignore these ABC items; however it might be useful 
to know that the ABC functions are compatible with MS Office -- ie. you 
can load the ABC data into Office.)

Later chapters describe these features. Don’t bother learning about things 
that you do not need. However, if you find you are spending time every day 
over some repetitive task (eg. producing address labels for parcels), look to 
see if ABC can help.

If you cannot easily see how to get ABC to save you time on some task, 
contact your After-Sales Support company, or ABC Software, explaining 
what you are wanting to do. Usually we can help.

The TOOLS MENU (top right of the screen) contains functions like Send an 
email to ABC Software, Auto-Update ABC, View the ABC website or User 
Forum, display your ABC Version number, and enter your Registration Key.
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Get started with Bookkeeping
ABC is designed to save you time and effort in looking after the mass of 
paperwork that is the bookkeeping in every small business.

At its simplest you can just enter details of everything you buy or sell, 
money received or paid. At the end of each month ABC can automatically 
produce neatly typed double-entry account books  exactly like a perfect 
hand-written system (but without the effort).

Take these books to your accountant at the end of year, and they will sort 
out depreciation, prepayments and accruals, assets, etc. 

Notes for Accountants: The emphasis in ABC is low level bookkeeping, and 
on screen we have hidden the complexities of accountancy. However, ABC 
is a full double-entry accounting package and could produce final accounts. 
(page 76).

Don’t trust computers!
Beginners (and some experts!) often think that anything printed out by a 
computer must be correct. This is not true! The computer is only a large 
calculator and if somebody types the wrong number, the answer will be 
wrong. If your neighbour operates an arc-welding unit, a surge through the 
power supply can make your computer turn out nonsense.

The thing to bear in mind with any computerised accounts system is that 
computers and computer operators CAN make mistakes. So you must check 
everything.

At least glance through at each stage to see if totals look reasonable. If you 
are not comfortable with a paperless system, ABC let’s you print anything 
or everything out on paper. You can then have your account books not only 
in the computer, but on paper in black and white.

Don’t keep separate handwritten books!
Everyone will advise you to run a new computer accounts system in 
parallel with your normal bookkeeping for a few weeks or months, to make 
sure it is working correctly. This advice is correct in general, BUT with 
ABC you can do this without having to do all that handwritten paperwork 
yourself. Here’s the secret:

Enter into ABC details of everything you buy and sell. Print the reports on 
paper. Now treat those pieces of paper as your handwritten account books, 
and check them carefully.

In the absolute worst case (eg. your computer goes wrong) you are still 
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better off! A Sales Daybook is a list of invoices with a total at the end no 
matter whether it was produced laboriously by hand, or printed out in 
seconds by a computer. 

Another factor is that if you do keep a separate set of books, it is often 
difficult to get exact agreement with the computer. You can end up wasting 
hours to find why the computer total is a penny different (often due to a 
mistake in your manual adding up). It’s much better to spend a fraction of 
that time on double checking the paperwork produced by the computer. 
You’ll achieve the same result.

If you are in doubt about this advice talk it over with your accountant. We 
are happy to speak to accountants about the best way to use ABC.

After the first few weeks
Once you have got used to working as described above, please continue to 
do this. Just because things appear to be OK for a few weeks, don’t assume 
everything will work perfectly for ever.

Paperless Office
This dream is finally starting to come true. With ABC you can produce 
month end reports, but save them as PDFs on disk instead of printing on 
paper (you can always print them later if you need to). And ABC can send 
invoices and statements by email instead of by post.

A typical month’s bookkeeping
During each month you would produce sales invoices on the computer 
using the Sales Ledger and enter details of unpaid bills into the Purchase 
Ledger. Collect together all petty cash receipts and other miscellaneous bits 
of paper (eg. till rolls) and enter these into the CashBook. You can do this 
each day, or every few days, whenever it is convenient.

When you receive a cheque (or cash) in payment of a sales invoice, enter 
this into the Sales Ledger (so you can mark the invoice paid) and not into 
the CashBook. When you pay a supplier’s invoice, start by telling ABC you 
have paid that invoice (in the Purchase Ledger) and the computer will then 
show you how much to write on the cheque and can print a Remittance 
Advice to send with it.

It is best to make entries approximately at real dates 
(ie do not get too far behind in your entries). It is a 
good idea to run the ABC Month End function within 
a few days of the real end of Month even if it means a 
some late items get entered into next month instead.
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After the end of the calendar month you can continue producing sales 
invoices (ie. with next accounting month’s date) while still entering unpaid 
bills from suppliers. Most people run the ABC Month End routine about 
a week into the next month. Before doing this, have a final check that you 
have entered everything into the computer from this month. Go through 
your bank statement and enter any bank charges or standing orders.

Then select the MONTH END function. This can be customised to 
automatically print out a lists, in the form of double-entry account book 
pages, of everything you entered during the month. (though these days 
many people save paper by not printing anything out unless it is required) 
That is the minimum you need to do!

ABC has taken care of all the calculations, adding-up columns and 
separating out the VAT.

If you are keen, you can do much more; for example print out useful 
Trading Reports (Profit/Loss) or Balance Sheet at any time showing a 
summary of the business, and reports to analyse sales and expenses.

More than one way
There often are several ways in which you could enter something into 
ABC Accounts. For example, if you cash a cheque at the bank  and put the 
money in your petty cash tin, this could be entered into ABC in three ways:

xx 1. Cashbook PAYMENT (cheque paid from the bank)

xx 2. Cashbook RECEIPT (cash received by petty cash tin)

xx 3. Nominal Transfer (amount transferred from bank to petty cash)

Any of these will work OK. (Method 1. is preferred because it allows you to 
enter the cheque number into the correct place). 

We give suggestions in the following pages on the best way to enter things. 
The general rule is to choose whichever method seems most natural, most 
like real life.  And don’t worry about it, this is just fine tuning. Even if you 
change your mind later you can enter an adjustment or transfer to move 
things around. ABC keeps you safe by preventing you doing anything 
invalid, and always keeping the books balanced.
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2
Getting started

Setting up the Accounts 
General Notes about VAT

Introduction
It is important that you set up ABC correctly to suit your business before 
you start using it to do the bookkeeping. For example, check that the VAT 
rates are set correctly, invoice numbers are set to the required start number, 
your Company Name and Address details are entered, and that any dummy 
information has been cleared from the files. Use the checklist below: 

If you create an extra company at any time, you must 
follow this procedure to set up that Company before 
starting to use it. 
If you are upgrading from an earlier version of ABC, 
the IMPORT function will take care of most of this 
automatically  (page 24)

RR 1. Set up Analysis Headings (Nominal Ledger Accounts) page 15

RR 2. Clear out any dummy information from the files 
and set your Accounting Year and the current Accounting Month. 
Set Folio Numbers. Also specify if you are VAT Registered.  page 18

RR 3. Enter your Customer and Supplier names and addresses. 
If you have been trading for a while there will probably be invoices 
already outstanding with these companies so you might choose to 
enter the amounts as Opening Balances.       page 19.

Getting started     |       13



14	 |	 ABC6 User Manual



Set up some Analysis Headings
The Analysis Headings (our word for Nominal Ledger accounts) are the 
centre of the Accounts system, and hold details of vague things like assets, 
profit, VAT, bank accounts.  Americans call it the General Ledger, whereas 
in the UK we prefer Nominal Ledger.

Think of the Nominal Ledger as a book with nine chapters. Chapter one is 
for Sales, Chapter four is for expenses, Chapter eight is for Current Assets, 
etc. Each Chapter is split into sections  for example Chapter four (expenses) 
might contain sections for Gas, Electricity, Postage, Insurance, Bank 
charges.

With a handwritten ledger the usual way to show these sections is with 
columns;  one column for Gas, one for Electricity, etc. The title or name 
of each column being written as a heading for the column. Splitting your 
expenses up in this way allows you to analyse your business -- see at a 
glance what you are spending on each item. In ABC we call these sections 
(ie. columns) Analysis Headings. (Accountants think of them as Nominal 
accounts).

The advantage of the computer is that you can create as 
many Headings as you need and analyse your business 
just how you choose 
 
.

Quick Tip:  ABC does include some example sets of Analysis Headings for 
some typical small businesses. You could just choose one of these and almost 
ignore the following couple of pages if you are in a hurry.

Each Heading is given a unique number;  those in Chapter one have 
numbers between 1000 and 1999, those in Chapter four between 4000 and 
4999. Some sample Headings (Nominal accounts) could be:  
            4223--Gas expenses,     4325--Telephone charges.

Before you start using ABC, you need to set-up the Headings to suit 
your own type of business. You don’t have to get this perfect first time, 
because you can alter things later; but it is sensible to get the Headings 
approximately correct before you start making entries.

We suggest you print the existing list of Headings (page 70), and work just 
on paper until you are satisfied you have a suitable list of Headings (an 
accountant might call this a Chart of Accounts).page 14.

Nominal Ledger > Print List of Headings
It is a good idea to talk to your accountant about this, and you do not need 
to use the computer at all; just pen and paper. A copy of last years accounts 
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would provide a good starting point.

It is easy to add more Headings later, if you find you need greater analysis 
of certain parts of your business. But it is difficult to delete Headings after 
you have used them (it upsets the audit trail). As a general rule, therefore, 
you should start off with very few Headings, and only add more when you 
really need them. Do not create a separate Heading for each Stock Item -- 
that analysis is better done using the Stock System.

Analysis Heading Groups
The Analysis Headings are divided into 9 Groups (chapters)

Group  Category of Headings (N/L Accts)  Db or Cr

1  SALES or INCOME.  Credit

2  OTHER INCOME  Credit

3  PURCHASES and COST of SALES  Debit

4  EXPENSES & OVERHEADS  Debit

5  CAPITAL EMPLOYED  Credit

6  LONG TERM LIABILITIES  Credit

7  FIXED ASSETS  Debit

8  CURRENT ASSETS  Debit

9  CURRENT LIABILITIES  Credit

ABC takes the totals of these groups and uses them as follows: (You can 
rename the groups, though that won’t change their function).

Gross Profit  =  Group 1 - Group 3

Net Profit  =  (Groups 1 + 2) - (Groups 3 + 4)

Turnover  =  Group 1

Liabilities  =  Groups (5 + 9 + 6)

Assets  =  Groups (7 + 8)

Working Capital  =  Groups (8  9)

Note for Accountants:  
An Analysis Heading is what ABC calls a Nominal 
Ledger Account. 
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Analysis Heading Numbers
Each Heading is numbered (think of it as the Account Number) and this 
number determines the properties of this Heading.

Analysis Numbers can range from 1000 to 9999

Headings in Group 1 have numbers beginning with 1.  
Headings in Group 2 have numbers beginning with 2, etc.

To make your Trading and Balance Sheet printouts look 
prettier (and to create sub-divisions within Groups) you 
can use some Headings as Group Titles, Sub-titles, and 
Totals. These sub-title and total Headings cannot be 
used for entering money; they are purely cosmetic.

Numbers ending in 000 are main group titles. 
Numbers ending in 00 are sub-titles. 
Numbers ending in 0 are titles of sub-divisions. 

Numbers ending in 999 are main group totals. 
Numbers ending in 99 are sub-totals. 
Numbers ending in 9 are totals for sub-divisions.

For example, Number 1000 is Main Title for Group 1

All other Numbers are normal Headings, and can have amounts of money 
entered against them.

For example, 8411 is Bank Account 1

The Subtitles and Subtotals allow you to divide your 
business up into departments if required. You could 
ignore these for now and add some later if you need to. 
 
.

Examine a List of Headings (page 14)  you will see how the titles and totals 
Headings appear, determined by their number.

If you add a new Heading to your list, give it an appropriate number. It is a 
good idea to leave a few gaps between numbers in case you decide later to 
add some further Headings in this area.
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Clear the Accounts Files
The original ABC installation contains some dummy information to let you 
experiment with the Accounts system. When you are ready to start using 
ABC for your business, you must clear out all the Accounts Files.

Accounts Utilities  >  Rarely used functions > Clear the Accounts
There are 3 stages to this process and you can complete them in any order.  
Before you can finalise (by clicking START) you will need to type the 
word YES into the box -- this is to convince ABC you are sure you wish to 
proceed.

xx Enter your company name and address details.

xx Are you registered for VAT?  Tick the box if you are,  
and also enter your VAT Registration number. (If you have applied for 
VAT registration, tick the box and put your number as “Applied For”)

xx Set the starting Sales Invoice number, Purchase Folio number, etc. If 
you already have a bookkeeping system you might choose to carry on 
with the same number sequence, or you could start from 1 (or from 
1000). page 21

xx Enter the Year & Month of the start and end of your Accounting Year.

xx Enter the Year & Month in which you wish to begin using ABC. This 
must be within your Accounting Year.

xx Choose ALL DATA (clear out Customer names/addresses also) 
or ZERO THE FIGURES and retain some data -- you can specify.

xx Select a set of Analysis Headings (Nominal Ledger Accounts) for your 
business. You can retain the existing set, or choose one of the presets 
included with ABC.  You will be able to modify these later, so do not 
worry too much about it at this stage.

The Headings (Nominal) descriptions are not cleared 
but the Heading balances are all set to zero. 
If you want to delete any Headings, this is a good time 
to do it (while they have no transactions). 
.

When all the above are set as you require, click START to actually clear the 
files.
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Set-up Customers and Suppliers
CAUTION regarding VAT: If you need to enter details from your old 
handwritten bookkeeping system into ABC, think carefully about the VAT 
involved in the old invoices. Either handle it outside of ABC (manually) 
or enter it into ABC and let ABC take care of it completely. Do not do 
both! (There is only one thing worse than paying VAT; and that is paying it 
twice!!) See item 3. below. Discuss this with your accountant if in doubt

It is not essential that you enter all your Customer and Supplier names and 
addresses into the computer before you start using ABC because you can 
add new records at the time you enter invoices. You might choose to ignore 
this section completely. However, if you want to enter your Customers and 
Suppliers first, here is what to do:

1. Prepare a list of existing customers and suppliers. These do not need to 
be in alphabetic order.

2. Add the new Customer and Supplier Records (page 26) 

You can add these records in any order. You can enter 
them all or just do some now and the rest later; or add 
new customers at the time you invoice them. 
 
It is possible to import data from .csv files. Contact us.

3. Choose from 4A, 4B, or 4C for how to enter old invoices. Method 4C is 
best (but involves most work). Most people probably use method 4B. 
If you are just starting a new business, then 4A is your choice.

4A. Do Nothing!  You are starting with blank files. (If you do have any 
invoices from before you started using ABC, you must continue to 
handle them by your old manual bookkeeping system -- they are 
nothing to do with ABC. Remind your accountant to combine those 
old invoices with the ABC books to produce your final Accounts at 
year end).

4B. Enter an Opening Balance. Instead of entering all the details of what 
a customer owes you, just enter the total amount (and this figure is 
put as the Opening Balance on their Account). One complication is 
that you must separately take care of any VAT relating to those old 
invoices. (If you are using the Cash VAT Accounting method, sorting 
out the VAT may be complicated -- you might find it simpler to use 
4C instead!!). 
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By just entering Opening Balances to Customer/Supplier records you 
are ignoring the VAT (this was accounted for at the time the original 
invoices were raised).  You have two choices for handling the old 
VAT:  
 
1.  Do it outside of ABC (eg by hand).  
 
2.  Work out the amount of VAT and enter this as an Opening  
      Balance to Heading 9211 -- VAT Control Account in the  
      Nominal Ledger (page 54)   
 
Decide on a starting date, usually the 1st of that Month you entered 
as the starting month. (page ) Calculate the balance for each customer 
and supplier AT THAT DATE. This will be their Opening Balance; 
enter it into ABC.

 4C. Enter all the old invoices into ABC. ie. go back in time a few 
months, and enter all the individual original invoices; ie. duplicate 
the manual system. You do not have to print these invoices when 
entering them but it might be useful. (page 63) If you do not have too 
many old invoices, this method is the best one to use.

ABC is very flexible. You may choose method 4C for some of your 
customers, but 4B for others. Just remember that once you have 
entered something onto the computer, you must account for it. If you 
enter invoices with VAT, you must at some stage also enter details of 
payment of that VAT to the government.

5. You can print on paper to make it easier to check what you have 
entered. Look at the reports to see the figures you have entered. This 
is a very good way of learning how a bookkeeping system works. 
For example, examine the List of Customers report and Aged Debtor 
report (page 66)

To correct mistakes in the Customer name/address 
details edit the Customer Record. (page 26)  You 
cannot directly edit the account balance so if you need 
to adjust the figure enter an Opening Balance (as a 
positive or negative amount).
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Company name and address
Your Company name and address details will be printed on reports 
(including invoices and statements) so take care to get everything correct 
(though you can edit them at any time).

Accounts Utilities >  Edit Company Parameters

                       FOLIO NUMBERS 
ABC automatically generates a unique Folio Number 
for each transaction you enter. These folio numbers 
then appear on all reports, audit trails, etc, making it 
easier to track the transactions. There are 5 sets of folio 
numbers: 
SL - Sales Ledger Invoices 
PF - ProForma Invoices 
PL - Purchase Ledger Invoices (Unpaid Bills) 
CB - CashBook entries 
JN - Nominal Ledger Journal entries. 
Normally you should not alter these during the year.

Check the VAT rates
Accounts Utilities  > Rarely used functions > Edit VAT Rates

Whenever you enter a transaction into ABC you must specify which VAT 
rate applies by selecting one of the following VAT Codes. Only edit the 
percentage rates if they do not match current VAT rates.

You can also edit the description (Notes) and Hints (tooltips) if required.

Code  Rate  Notes Hint

0  Zero rated goods books, food; also exports (tooltip)

1  Standard rate (eg. 20%) most sales and purchases

2  Alternative rate 2

3  Alternative rate 3

4  EC zero rate

5  EC Standard rate most EC sales and 
purchases

6  EC Alternative rate

E  Exempt from VAT

N  Not applicable internal transfers, wages
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VAT  General notes 
There will be occasions when ABC queries the VAT Amount you entered 
because it does not exactly agree with the expected amount.

a) If you have made a mistake, then change your entry.

b) If you had a valid reason for entering this VAT Amount (see next 
paragraph), then you can select Continue.

Mistakes involving VAT
If you spot an error on the piece of paper you are entering into ABC:

(1) If you recently created this piece of paper (for example, a Cash Sale 
Receipt), and no copies have been given to anyone else; then you can 
tear up the paper and start again with a corrected version.

(2) If you have already sent someone else a copy of this piece of paper, 
or if you are entering an invoice or receipt from a supplier; then you 
must enter the incorrect figures into the computer exactly as they 
appear on the paper. 

Sales Invoices - cosmetic adjustment
VAT can be worked out line-by-line or calculated on the invoice total. 
ABC uses the line-by-line method (as this allows you to mix VAT rates on 
the same invoice), but humans usually use the invoice total method. Both 
methods are acceptable, but could give slightly different results (eg.a few 
pence difference). This may worry your customers if they check the invoice 
using the other method.

ABC tries to be smart! If all lines on the invoice have the same VAT rate, 
then the program will try to adjust the VAT total so that the line-by-line 
method gives the same result as the invoice total method. The small 
adjustment is made to the first line of the invoice. It should be stressed 
that this is being done purely for cosmetic reasons; the VAT Inspector will 
accept either method (see HMRC VAT Regulations if you don’t believe us).

Cash VAT Accounting
ABC automatically allows for Cash-VAT-Accounting (the system where you 
do not have to pay VAT to the government until your customer pays you). 
There is nothing you need to do differently in ABC whether you use Cash-
VAT or normal Accounting.

For Cash VAT Accounting ABC treats part-paid Sales Invoices as fully paid, 
and part-paid Purchase Invoices as unpaid.  If an invoice is for a large 
amount and only a small part is not paid, it might be better to split the 
invoice into two separate invoices so the large part can be marked paid.
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Print the VAT Return 
You can choose a standard VAT Return, or the Cash-VAT Accounting 
Return (which includes some additional pages showing how ABC arrived 
at the results). In either case, you should check the figures carefully before 
proceeding. page 70

From April 2011 all companies are required to submit their VAT Return 
Online.  ABC6 is approved by HMRC to do this. You must view the VAT 
Return before you can press the button to send it to the government 
website. When you send your VAT return Online ABC will display the 
message the government sends back to you -- print this out and keep it with 
your records.

A full VAT Audit Report can be printed, listing all the transactions 
containing VAT within the date range you specify. VAT Returns can also be 
reprinted for past periods.

Notes for the VAT Inspector
ABC can produce an audit trail of everything that has been entered during 
any specified period; and this can be printed on paper for easier inspection 
or record keeping.

Every report has a separate column for VAT, with a summary at the end. 

The ABC VAT Return can list all VAT transactions during the period, 
followed by details of any calculations or adjustments to those figures. 
Finally, the last page shows the entries required on the VAT submission. 

Please contact ABC Software if you have any queries or wish to discuss 
ABC   (page iv)
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Import from ABC5
ABC includes a function to import all the Accounts data from your old 
version of ABC5. This process does not affect the ABC5 files at all, and you 
could continue to use the old ABC5 for a while. This function can be used 
at any time, and you can use it more than once if you wish.

If you have more than one Company in ABC5 then 
first you must create a corresponding new Company in 
ABC6 and then ensure you are in that Company before 
using Import. You need to do the Import separately for 
each Company.

Accounts Utilities > Rarely Used > IMPORT FROM ABC5
Select which of your old ABC5 Companies to import from (if you have more 
than one). The Import process may take a few minutes if you have a lot of 
history. While importing the data, ABC6 will check the records and will 
skip any damaged or deleted records. Check the text in the progress box on 
screen for a report on what has been imported. 

Import from other software
Over the years we have a lot of experience importing accounts data into 
ABC from programs like SAGE, QuickBooks, and Excel spreadsheets.  This 
is usually quite easy and is not a big job. However, it is not feasible to 
include import routines for all the many and varied versions of different 
programs available, and therefore we offer a service to do this sort of thing 
for you. At the same time we can manipulate and carefully check the 
consistency of the data to ensure you have a perfect set of accounts  to get 
started with ABC.

Contact us to discuss anything like this.    (page iv)
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3
Record cards

Add new Account Record Cards 
Edit existing Accounts 

Customers  Stock Items  Headings

ABC keeps a Record Card for each Customer Account, to store their name, 
address, balance, history, notes, etc. The Record is split into several tab 
pages (see example above).  Similarly there is a Record Card for every 
Supplier, Stock Item, and Nominal Account (Analysis Heading).

This chapter explains how you can view or edit existing records, add new 
records, or print a record. Full details are given of the information that is 
stored in each Record Card.
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Customer and Supplier Records
Supplier and Customer Record Cards are similar, so this section applies 
to both. Select Sales Ledger for Customer Records, or Purchase Ledger for 
Suppliers: (There is an extra tab on Supplier Records for Purchase Orders; 
this is greyed out -- non working -- if you do not have this extra module).

Sales Ledger > Customers and Sales Entries

We talk about the Customer Record Card  but an 
accountant will probably call it the Customer Account. 
(and a programmer might think of it as one Row in the 
Customer Table.) 

The list panel to the left of the Card allows you to find a particular 
customer and then view or edit their Record Card.       (page 109)

Create New Customer Record
Select ADD from the ribbonbar.  A blank Record Card is displayed. Fill in 
the name and address details as explained below.

Edit or View Customer Record
Find the Customer Record that you require. Select EDIT from the ribbonbar 
if you want to change anything (experts can bypass this button) (page 110).

Some Fields are updated automatically by ABC and you cannot change 
them (eg. the Account Balance).

Details of each Field
The Customer (or Supplier) Record Card has Fields for the name, address, 
credit limit, balance and other details. Each Record Card has several tab 
pages containing groups of Fields (described below). Many of the Fields can 
be left blank -- you can edit them later if required. 

Field Name Description and Notes

Account 
Number

This is generated by ABC to ensure each customer has 
a unique account number. You cannot change this.

Key This is just a shortcut or nickname for the Customer 
that you can use to quickly locate their Record. 
Enter any code or abbreviation; or leave it blank and 
ABC will fill in the first few letters of the name as a 
suggestion.
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Field Name Description and Notes

Company 
Name Address 
and Postcode

Enter the business name and address of the Customer 
(Supplier). ABC will use this when printing 
statements, invoices or letters, so check it carefully. 
The EC Field is a 2 character European Country code.

Telephone and 
Contact Name

ABC will use this when printing a list of Customers 
(or Suppliers) and Aged Debtor Lists.

Mobile 
phone and 
fax numbers. 
Email address

 Can all be left blank if not required.

Current 
Balance

The total amount owing on this account at this 
moment. You cannot directly edit this Field. When 
you enter a bookkeeping transaction (for example 
an Invoice or Money Received) ABC will update the 
Balance.

Year to Date The total amount of trading for the current 
bookkeeping year, up to today’s date. ABC updates 
this automatically.

Credit Limit ABC will warn you during invoicing if the account 
balance is approaching this Credit Limit (you might 
then choose to ignore the warning..... that’s up to 
you!). If you leave it blank (or set at 0) then ABC will 
not check the Customers credit limit.

Previous Year 
total

You can leave this blank. Or you can fill in an 
approximate total of how much business you did with 
this Customer (Supplier) last year (excluding VAT). 
ABC will automatically update this Field during the 
Year End.

Last Invoice 
Month

ABC automatically updates this field with the 
bookkeeping month number (eg 201403 for March 
2014) of the last time you sent/received an invoice.

Last 
Transaction

Leave this blank. ABC will keep this field updated 
with the date of the most recent transaction for this 
Customer (or Supplier)

Unallocated 
and 
Overdue 
(indicators)

If this Customer (Supplier) has a money or credit note 
item over 30 days old and not paid, the indicator will 
glow red. Even if the Balance is zero because you have 
entered their payment, the indicator will glow to show 
that items are not yet allocated (marked paid).

Record cards     |       27



Field Name Description and Notes

History or 
Outstanding

The grid (table) will display the transactions for this 
Customer (Supplier). You can choose OUTSTANDING 
to see only the unpaid items; or HISTORY to see 
everything.  Right-Click an invoice to Zoom or reprint. 

Note 1 A single line of text for your own use.

Note 2 A single line of text for your own use.

Note 3 A single line of text for your own use.

Memo This can store a large amount of text (many hundreds 
of lines).

Customer Ref If the Customer refers to you by a code or account 
number; you can enter it in this Field. This can be 
printed on sales invoices.

VAT 
Registration

The Customers VAT Registration number; as required 
for reclaiming EC VAT.  Can be left blank.

Delivery 
Address

The Customer might have different addresses for 
deliveries and for invoicing. ABC allows you to store 
several different delivery addresses for each Customer.  
Leave this Field blank -- ABC will automatically fill 
in the code of the last Delivery Address used for this 
Customer. (You can edit the Delivery Addresses while 
producing a Sales Invoice).

Agent For your use (or used by Sales Order Processing)

Type of 
accounting

You can specify Open Item or Balance Forward 
accounting for the Customer. The default is OPEN 
ITEM (which is what most people prefer).

Settlement 
Discount

Tick this box if you wish the Customer to be offered 
a Settlement Discount on sales invoices. Also set the 
percentage and number of days.

Cash with 
Order basis

Tick this box if you do not want to allow this 
Customer any credit (ie. they must pay cash for any 
goods or services)

Use VAT 
Inclusive 
prices

If you tick this box ABC will treat all prices entered 
when invoicing this Customer as VAT Inclusive. This 
is useful if your goods are marked with retail prices. 

Zero  rate VAT If this Customer is a registered Charity for example.

Inactive If this box is ticked, the Customer will remain in the 
files (so you can reprint old reports) but can be hidden
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Field Name Description and Notes

Price Group The Stock System can store 3 different prices for 
each item. When invoicing this customer Price1 will 
normally be used. If you tick the Price Group 2 box, 
or Group 3 box, then Price 2 or 3 will be used when 
invoicing this customer.

Trade 
discount

If this Customer nearly always has a trade discount 
then you can enter the discount percentage here, 
eg 10%. ABC will use this as the default when you 
invoice this Customer.

Terms For your use. eg.  Strictly Nett. Payment within 30 
days. These terms can be printed on Sales Invoices.

View or Print
While looking at a Customer (or Supplier) Record; you can view or print 
a Statement (list of all unpaid items) or History (list of every transaction 
-- you can specify a date range). Other options on the View/Print Menu are 
address label, mail-merge letter, envelope. 

If you want to print details of ALL (or several) Customers; then select a 
Report from the Sales/Purchase Ledger Menu -- eg. to print Statements for 
all Customers with outstanding items (page 68)

Reprint (or view) old  Invoice
Right-click on an invoice in the History Grid, and select Zoom to view or 
reprint.

Mark as Inactive
Select the Customer (or Supplier) Record Card, and click MARK INACTIVE 
on the ribbonbar. This will tick the box “Inactive Record” on their Record. 
The Record will not be removed from the file (to keep the audit trail intact), 
but you can tell ABC to hide Inactive records. 

To restore a Record to Active, edit the Record Card and 
untick the MARKED AS INACTIVE box on the Options 
tab page. 
 
Click the button on ribbonBar to show/hide Inactive.
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Purchase Orders
Purchase Order Processing is an optional extra and has its own manual.

Analysis Heading Records (Nominal Ledger Accounts)
The Nominal Ledger is for details of vague things like assets, profit, VAT, 
bank accounts. Also known as the General Ledger. (page 15)

ABC keeps a separate Record Card for each Nominal Account (Analysis 
Heading), as shown below. The bottom half of the window shows 
transactions relating to that Analysis Heading. Click an option button to 
select This Month, This Year, or All transactions. Click on the title of a 
column in order to instantly sort the grid into that order (click again for 
reverse order). 

Create a new Nominal Account (Heading)
Select ADD from the ribbonbar. A blank Record is displayed. Fill in the 
details (see next section). The number (Code) you give this Heading is 
important as it specifies what type of Account it is.   page 16.

It is very easy to add new Headings at any time, but not so easy to delete 
them (without upsetting the Audit Trail). Our advice is to only add a new 
Heading if you really need it.
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Edit a Heading Record Card
Find the Record Card you require (page 109) and select EDIT. 

You may find it useful to print a List of Headings on paper (page 70).

For hints and tips on editing Fields, page 110.

Details of each Field

Field Name  Description and Notes
Heading 
Number 
(or Code)

Also known as the Nominal Account Number, or Heading 
Code. Each Heading Record must have a unique number. 
The number determines the type of Account. page 16.

Short 
Description

A brief title for this Heading. This will be used where there 
is not space for the full description (below). eg MTB Ladies

Full 
Description

The full title for this Heading (Nominal Account) eg. Sales 
of Mountain Bikes (Ladies Size)

Current 
Balance

The total amount that is in the Account at this moment. 
Only ABC can change this Field.

Month to Date The total of all transaction entered into this Heading during 
the current bookkeeping month. Only ABC can change this 
Field.

Start of Year 
Opening 
Balance

The figure that was in the Heading at the start of this 
bookkeeping year. This is normally zero for all Trading 
accounts (eg Sales, Purchases, Expenses)

Budget For your own use. For example; you can print a report 
comparing actual balances with budget figures. Can be left 
blank.

Debit or Credit Depending on the type of Heading this is; ABC displays 
whether it is a Credit or Debit account. (only an accountant 
could be interested in this)

Type of 
Account

The Headings (Nominal Accounts) are divided into 9 
categories or types. (page 16). ABC fills in this field 
automatically based on the Heading number (Code).

Last Year For the Trading accounts (eg. Sales) ABC keeps a note here 
of the total entered into this Heading last year. 

This Month 
or Year, or All 
Transactions

The grid (table) displays the transaction history for this 
Heading. You can switch between viewing just this month’s 
transactions, or the Year, or All transactions. You can also 
choose whether to include or hide items with future dates.
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Headings with Analysis CODES above 5000 are Balance 
Sheet Headings. 
 
Headings with CODES below 5000 are Trading 
Headings

Delete a Heading Record
Select Delete from the ribbonbar. Some Heading Records cannot be deleted 
because:

a) some Headings are used by ABC for automatic postings. These include: 

1971 Sales Discounts 8395 Contra Payments

3971 Purchase Discounts 8411 Bank account 1

3981 Stock adjustments 8471 Petty cash tin

5111 Trading Profit C/F 8481 Money on Premises

5281 Opening Balance 9111 Purchase Control

8111 Sales Control 9211 VAT Control

8121 Stock Value 9221 PAYE Control

b) Headings that have an amount in the  Balance Field, or which have 
been used recently, cannot be deleted.

Also, the Group Title and Group Total for a Group,  ie. Headings 1000, 
1999, 2000, 2999, etc, cannot be deleted.

Although you cannot delete these Headings, you 
can edit the descriptions to better match your own 
business. 
 

Recalculate All Headings
When you change any heading (eg. by entering a transaction) ABC will 
automatically also recalculate any sub-totals and totals that are affected. 
However, there are circumstances where this does not happen so you can at 
any time tell ABC to do this. While viewing any Heading record, click the 
ribbonbar button RECALC BALANCES. It is safe to do this at any time. ABC 
will also do this automatically during each Month End.
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Stock Record Cards

Introduction
Some people use the word Inventory instead of Stock. 
Each stock item is given a Record Card in the Stock File to store details like 
description, quantity in stock, price, and even a picture if you wish. 

Some businesses may not need a stock control system but you can also use 
the Stock Records for keeping “text-only” Records to store commonly used 
phrases or notes. These can then be used on Sales Invoices when required.

For a Stock System to be useful you must keep it up to date.

The ABC Stock System has some advanced features. For example you can 
specify the type of calculations ABC makes when you buy new stock at 
a different price, or set Cost Price and Markup percentage, and ABC will 
calculate the Selling Price (with and without VAT). And you can ask ABC to 
warn you when the stock level of an item is getting low. 

Stock System > Stock Records

Edit Stock record

Find the stock item you require (page 109) and select EDIT from the 
ribbonbar. (Experts can turn off this step). Hints for editing Fields, page 110.

The Stock Record Card has Fields for the description, cost price, selling 
price, etc. These are spread across several tab pages, and described in the 
following table. The Channels tab page allows you to have different selling 
prices for different Channels (eg. your website, eBay and Amazon).
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When you SAVE the Stock Record,  ABC can recalculate the Selling Prices 
or Markup if you wish. You can set your preference on the Details tab. 

You can choose to display various transactions in the History Grid at the 
bottom of the description tab page.  Tick the option boxes to show Sales, 
Purchases, Adjustments, and either full history or this month only.

Stock Item measure -- types of Stock Item
You may have different types of items in stock. For example, one “unit” 
may be a microwave oven, a box of 24 lightbulbs, a roll of 50m of ribbon, 
etc. On the Details tab page you can specify how each stock item should be 
described (change the Description, Qty, and Measure; then click UPDATE). 
You can also have “text-only” stock items. 
If you do not fill in anything here, ABC assumes each item is 1 unit.

Hide or Show the Details tab (Prices)
If you untick the DETAILS box (on the Description tab page) you cannot 
access the Details tab which shows Cost price and profit margins. This is 
useful if you may have customers looking at the screen and you wish to 
keep those details confidential.

Add new Stock record
From the ribbonbar select ADD. A blank Record Card is displayed, and you 
can fill in details of a new stock item (see below). You can also create a new 
Record by Cloning an existing stock Record.  > click CLONE RECORD.

Pictures of Stock Items:
To set or change a picture, select EDIT and then click the PICTURE button. 
Pictures can be .jpg, .gif, or .bmp and must be located in the data folder for 
the company (eg. \ABC6\A_DATA ).  The ideal size is 275x200 pixels, 96dpi.

Alternatively you can fill in the picture name on the Channels tab page, 
either manually or by importing the names. 

Delete Stock record
From the ribbonbar click DELETE.

If you have used (eg. bought or sold) this item recently, then it may be 
better to wait for a while before deleting it (otherwise the Stock History will 
have a gap).

Details of Fields
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Field Description
Stock Code Any code or number. It must be unique. You will use this to 

quickly call up the stock record; so we suggest you choose 
codes that are short, meaningful and easy to remember. Up to 
16 characters.

Short Descr. A description of the Stock Item. This can appear on printouts 
and Invoices. 

Barcode Optional barcode of the stock item.

Manuf. Code Optional manufacturer’s part number or code for this item.

Warn if low 
tickbox

When producing a Sales Invoice; ABC will warn you if the 
Stock Item you enter is out of stock; if this box is ticked. 

Quantity on 
Order

You can enter the quantity of units that you have already 
ordered. 

Re-order 
Quantity

When you need to re-order this item, how many units do you 
normally order? This will be shown on the RE-ORDER LIST

Minimum 
Quantity

The lowest quantity of units that you require normally to have 
in stock. The NEED RE-ORDER LIST will show you all Stock 
Items where the Quantity in Stock is below this Minimum..

Allocated The quantity of units you have sold but do not have in stock 
ie. on order and reserved for someone.

Location It may be useful to specify a shelf or warehouse location. 

Weight (Kg) The weight of the item in Kg

Size (cm) The dimensions of the item in cm (eg. 5x12x10)

Spare 1 For your own use only. ABC does not  use this field.

Note A large memo field that can contain many lines of text. 

Unit Cost The unit cost excluding VAT. This is used for automatic 
calculations and valuation reports. 

Case Cost No longer used by ABC (replaced by “measure”)

Case Qty No longer used by ABC

Suppliers You can note your main Supplier and a second source here. .

Account Nbr The Account Number of Supplier 1. Required by Purch.Orders

P/L Heading 
Code

The default Purchase Heading Code to analyse this item under 
when entering purchases. 

Purch. Dept. The default Purchase Department for this item (not yet used).

Last-In Cost For comparison when next you re-order.

Last in Qty The number you last purchased. (ABC uses for calculations)

Method For your own use
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Field Description
Case Disc’nt No longer used by ABC

Selling Prices 
(Excluding 
VAT)

The Selling Price excluding VAT. If you leave this blank, ABC 
can calculate it from the Unit Cost price and the markup 
percentage. You can have three different prices for each stock 
item. (On the Customer Record you can specify which Price 
Group should be used for that Customer: 1, 2 or 3.) page 29

Selling Prices 
(Including 
VAT)

The Selling Price including VAT. If you leave this blank ABC 
can calculate it as above, adding on VAT at the current rate 
dependent on the VAT CODE Field.

% Markup You can specify how much profit you wish to make on this 
stock item and ABC will use this figure to calculate the selling 
price (if you leave that Field blank). Alternatively, leave the 
Markup % blank and ABC can calculate the percentage from 
the Selling Price and Cost Price

Month to 
Date Sales 
(MTD)

The number of units that have been sold this month, at each 
Price Group. Normally you would leave this blank, and ABC 
will fill-in the figures as you produce invoices.
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Field Description
Re-Calculate 
Prices 
options

You can set options for getting ABC to recalculate prices when 
the Stock Record is Saved. These can be set differently for 
each stock item.

VAT Code Specify the VAT Code that normally applies to this stock item. 
If you leave it blank, it defaults to Standard Rate.(Vat Code 1)

S/LHeading 
Code

The default Sales Heading this item will be analysed under 
when invoicing. (but you can change it when invoicing)

Sales Dept. The default Sales Department Code. (not currently used)

MTD ABC fills in the total quantity sold this Month To Date

Year to date ABC fills in the total quantity sold this year (so far)

Average per 
month

ABC calculates the average quantity sold each month. This 
figure will get more accurate as months go by.

Type of Stock 
Item

A Stock Record can contain a NORMAL item (eg. some goods 
or service; with a price); or just some text -- TEXT ONLY. The 
difference is that ABC automatically adjusts the Qty In Stock 
Field as you buy and sell Normal Items but does not do this 
for Text Only Items.

Available to 
sell

For each Channel there is a tick box you can use to specify if 
this item is available to sell on that channel. Just untick the 
box to say the item is currently not available.

Channel 
Price

For each Channel you can specify a selling price. This allows 
you to have different prices on different Channels.

Category Channels may have their own code to specify the Category 
and Sub-Category this item should be listed under.

Long 
Description

You can fill in full details of the item here. This description 
can include HTML code for formatting (set fonts, colours, etc)

Description 2 Another description field. This could be used for the brief 
product description to list the item under for the Channels.

Picture file The name of the image for this item. Normally you simply 
browse to select the picture (on the description tab page) and 
ABC will fill in this field. However, you can edit this field 
directly (or import/export it for the channel if required).
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Adjustments
The Adjustments tab page is a special section and when you enter this tab 
page you cannot leave until you click FINISHED or CANCEL. This section 
allows you to manually adjust the Stock Quantity (by simply setting the 
current quantity to the correct figure -- it does NOT create a transaction in 
the file: that’s why it should only be used rarely, eg. after the annual stock 
take, to bring the stock levels to the actual values.

When you have finished you can print a report showing the changes you’ve 
made. Note that the Quantity Allocated or Quantity On Order fields are not 
affected by this process.

Global settings
Accounts Utilities > Edit Company Parameters > Stock

You can set various options here to choose how you want the stock system 
to work. Including:

xx Calculate new cost price when you buy stock at different prices, 
using Last In price, or weighted average, or manually adjust.

xx Number of decimal places for Cost prices and selling prices. With 
option to force all stock items to this,

xx Make all stock quantities whole numbers.

xx Allow stock transactions with future dates, or not.

After changing these settings you can get ABC to go through the stock file 
and force all records to conform. 

Selling through other Channels
Not yet fully implemented, this is intended to allow you to use ABC as a 
master database of inventory, and then to export CSV files to update each 
Channel you are using(eg. eBay and Amazon). Ignore this tab page if you do 
not need this feature.
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4
Transactions
Enter details of payments, 
receipts, banking, stock, 

or create invoices

There are many types of transaction in your business, for example 
purchasing goods from a supplier on account, buying a few stamps from 
petty cash, paying money into the bank, producing a sales invoice when 
you sell something, receiving money from a customer to pay thier bill. 
To make it easier to enter the different types of transaction, ABC has 
appropriate entry routines to suit each type.

In general terms, if the amount of the transaction is more than a few pounds 
you should have a piece of paper to prove that the transaction is genuine. 
Figures on a computer screen are very neat, but the VAT Inspector and 
Accountant prefer traditional bits of paper like bank statements, cheque-
stubs, invoices, petty cash receipts. If you do not have a bit of paper, then 
create one; write the details of the transaction onto a blank sheet, and put 
that into your ring-binder. Every transaction entered into ABC is given a 
folio number; (page 21) you should write this number onto the bit of paper. 

We recommend you get into the habit of always doing this in some 
distinctive way; eg. get a rubber stamp, or use a purple pen, and always put 
the number in the bottom right hand corner of the document. This makes it 
easy to check, and if you find a document with this number on it you know 
it has already been entered into ABC.

When it comes to entering transactions into ABC, you can save time by 
collecting together similar items and entering them as a batch.

Now that online banking and shopping are so widespread, many people 
are not using paper at all. This is great, but take care that you do still have 
a proper record of sales and (in particular) purchases) in a format that will 
satisfy a suspicious VAT or Tax inspector. Discuss this with an accountant 
to be on the safe side.
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First thing to do is decide which type of transaction you are entering. Here 
are the most common

Money Received - page 41

Invoice payments (for credit items, relating to a Sales Invoice)

Cash sales (miscellaneous non-credit items, eg till receipts) VAT Refund 
from Government

Money Paid - page 51

Pay a bill (purchase invoice)

Cash payments (petty cash) (for miscellaneous non-credit items) 
Including: Wages to employees; NI, PAYE to government;  Proprietor 
drawings; VAT Return to Government

Internal Adjustments - page 53

Bankings (take Money on Premises to the Bank); Write a cheque for petty 
cash tin; Opening Balances for Customers or Suppliers (Sales Ledger, 
Purchase Ledger); 

Opening Balances (Nominal Ledger);

Transfers (Nominal Ledger Journal)

Stock (Inventory) - page 57

Stock Adjustments (enter results of Stock Take); 

Goods In or Out.

Unpaid Bills (from Suppliers) (Purchase Invoices) - page 58

Sales Invoices - page 60

Create new invoice, or enter details of a handwritten invoice.

Also Credit Note, Proforma Invoice, or Delivery Note.

Corrections (adjustments) - page 64

Everybody makes mistakes from time to time. When you spot something 
wrong, simply enter a correction.

The following pages describe each type of transaction, and explain how to 
enter it into ABC.
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Money Received
Decide if this is  

A. a payment for a Sales Invoice,  or 
B. a small miscellaneous sale (eg. via the shop till) 

A. Payment received for an invoice
Sales Ledger > Customers and Sales Entries  
> Find the Customer  > Receive Money

You can also find a customer record by entering:. 
   a) Invoice Number, eg. enter SL1234 
   b) Account Number. eg. enter #321 
 
(ie. enter SL to find Invoice,  # to go to Account Nbr)

The normal procedure is to first enter the amount of money received (and 
the date, payment method, etc). Then you can allocate this against one or 
more invoices to mark them as paid.

However, you could just enter the money and Save.  Later you can mark 
items paid -- by allocating Credit Notes, Opening Balances, etc against 
invoices.  You can also part-pay any invoice. 

Sometimes you may allow the Customer a Discount. And occasionally the 
Customer will pay the wrong amount (eg. send a cheque for £34.12 instead 
of £34.21). ABC makes it easy to handle these entries.

You can even make ABC automatically allocate any 
receipts against invoices at month end and this brought 
forward option can be set for just some customers.  
Page 28 

Enter money details
The entry screen for you to enter details of the money transaction is shown 
on the next page. 

ABC gives every transaction a computer Folio Number (eg. CB010027)  as 
you enter it, and you may want to make a note of this (eg. write it onto the 
Bank Paying-In slip).
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Details of Fields for entering money received

Field Description

Amount received The amount of money received from the 
Customer.

Method of 
Payment

In what form was the money?  page 108 

Date of this 
transaction

Today’s date is provided as the default; but you 
can change to a different date. ABC expects 
the date to be within the current bookkeeping 
month; but you can put a future month if 
necessary. You cannot use a previous month 
date.     page 107 

Paid Into Specify the Analysis Heading where this money 
will be placed. Normally it should be the 
MONEY ON PREMISES (for cash/cheques); but 
could be a BANK (if Direct Debit etc).  Page 107

Our Reference A reference number or name (eg. the initials of 
the person making this entry; or the number 
from your bank paying-in book page)

Note A description of this transaction. Can be left 
blank.
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Discount
If you tick the ALLOW DISCOUNT box, additional Fields appear to allow 
you to enter and calculate a Discount for this payment. 

The Customers account balance will be reduced by the Amount of money 
they have paid, plus the discount. 

Field  Description

Amount Received The actual amount of money received from the 
Customer.

Discount percentage ABC displays this automatically (in brackets).

Discount You can enter an amount here; or enter a 
percentage (eg 3%)

Total ABC calculates this figure automatically. This 
is the amount by which the Customer account 
balance will be reduced. You can play about 
with the above Fields to get the Total to what 
you require, and then tick the FREEZE box (to 
keep the total fixed). Now you can adjust the 
other Fields as required. 

Allocate (mark invoices paid)
Select the Allocate tab page. This shows all unallocated items for the 
Customer (Invoices, Credit Notes, Discounts, Opening Balances, Brought 
Forward amounts, and Money Received).

These all need to be Allocated where possible -- for example, to mark an 
Invoice as paid by allocating Money or Credit Note against it. This can be 
done at any time.  If you are using Cash VAT Accounting it is important to 
Allocate as many items as possible before printing a VAT Return.

In the left column you can enter:

   Y -- YES, PAID in full (Allocate this item) 
   P -- to Part-allocate (then you enter the amount to part-pay) 
   N -- NOT PAID (ie. cancel either of the above)
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It is this process that alters the Amount Outstanding 
Field in the history/statements. When the outstanding 
amount is zero; an item is considered paid. You can 
also part-pay an item. If this Customer Record has 
the Option set as Brought Forward the computer will 
automatically allocate any money against the oldest 
invoices during the next Month End.

As you Allocate each item the Allocated TOTAL will change. We 
recommend you begin by allocating any money, credit notes and discounts  
these all will decrease the Allocated Total. Now start allocating invoices and 
any Balances Forward  this will increase the Total.  Stop when the Total gets 
back to zero (ie. an exact match between money and invoices). 

If you select SAVE when the  Allocated Total is not zero, ABC will query 
this, and offer you several alternatives to get rid of the discrepancy:

STORE AS BALANCE  create a new Brought Forward item.

WRITE-OFF (as a Discount)  useful for small amounts, eg. if a Customer’s 
cheque is wrong by 2 pence.

ALLOCATE  go back and try again.

EDIT MONEY  go back to previous section and edit details of the 
payment received.

Refund to a Customer
Treat this the same as Money Received from a Customer (see above) but 
enter the amount as negative.

Contra Payments
If you owe a Supplier for an invoice, and they also owe you some money, 
you can cancel one against the other to save you both having to write out 
cheques (obviously they must also agree to this). This is known as paying 
by contra.

You should enter both the Sales and Purchase sides of this transaction 
at the same time, and the amount must be the same in both cases. (If the 
invoice on either side is of a greater value, then just mark that larger invoice 
as part-paid by the smaller amount).

Use the special Heading 8395 for all Contra Payments.
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B. Cash Sales income
ABC gives you great flexibility when entering CashBook income. You 
can enter a batch of transactions (or just one) and then post these to the 
accounts immediately. Or you could store the batch, and continue entering 
at a later time (may be useful to let someone else check the entries before 
they are made final). You can print the batch of entries on paper, before or 
after finalising them.

Cashbook > Cash Income
You can switch between the previous batch and the current batch of 
entries. When you finalise the current batch it is posted to the accounts and 
becomes the previous batch. Only the current batch can be edited.

ABC generates a CashBook Folio Number (eg CB001234) for each item that 
you enter. We recommend you write the Folio Number onto each receipt 
or bit of paper as you enter them into ABC -- this makes it easy to cross-
reference from the Audit Trail later. page 21 

The following Fields must be completed for each line.

Field  Description

Date The date must be within this bookkeeping 
month; or a future month. page 105

Analysis Heading What was this amount for? Enter an Analysis 
Heading CODE.      page 105
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Note Imagine you are looking at a list in six months 
time; and trying to remember what this entry 
was for. The note will appear on the list; try to 
type something meaningful.

Reference For your own use. For example; the Bank Paying-
In Book page number. Or your initials.

Amount Enter the total amount (including VAT).

VAT Code The VAT Code for this transaction. page 108

VAT Amount Enter the Amount of VAT.  
 
VAT Calculation: With the cursor in the 
VAT Amount field; you can press F8 and the 
computer will calculate the VAT amount for you 
(at whatever rate you specified with the VAT 
CODE).

Method In what form was this money? Cash? Cheque? 
Direct Debit?    page 108.

Bank Heading Where did you put the money?  The Petty Cash 
Tin? Money on Premises, or directly to a Bank if 
it was a Bank Transfer? 

As you complete each line, the amounts are added to the Batch Total at the 
bottom of the screen. You can Cursor up or down to move back and correct 
any entries you have just made. 

You can save your work and resume tomorrow, or finalise the batch 
immediately. 

The Summary Tab Page shows an analysis of the Headings you have used, 
and the VAT split. You can print a Batch Report at the end. Some people 
find it useful to print this list of what they have just entered, and store it in 
a ring-binder with any associated pieces of paper (eg. till rolls).

VAT refund from the Government
Enter this as a Cash receipt, with VAT Code N (Not Applicable). The 
Analysis Heading is 9211, and the Cash/Bank Heading is wherever you put 
the money, eg 8481-Money On Premises or 8411-Bank.
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Money Paid
Decide if this is a  

A. Payment for an Unpaid Bill (Purchase Ledger Invoice), or  

B. Small sundry (ie. “cash”, not “credit”) purchase. (eg. wages, VAT or tax 
payment, petty cash for stamps or petrol)

A. Purchase Ledger Invoice payments
Normally it is convenient to first “tick” the unpaid bill(s) that you wish to 
pay, and ABC will show the total amount of money. ABC does allow part-
payment of invoices, and paying of several invoices at one time. You can 
instead also just make an arbitrary payment to a Supplier.

A Remittance Advice Note and/or Cheque can be printed.

Purchase Ledger > Supplier Records and purchases  
   > Find Supplier Record >  Money Pay

You can also find a supplier record by entering:. 
   a) Invoice Number, eg. enter PL1234 
   b) Account Number. eg. enter #321 
 
(ie. enter PL to find Invoice,  # to go to Account Nbr)..

The Allocate Tab Page shows a list of all unallocated items for the Supplier 
(these can include Invoices, Credit Notes, Discounts, Opening Balances, 
Brought Forward amounts, and Money Paid).

These all need to be Allocated where possible -- for example, to mark an 
Invoice as paid by allocating a Money Paid against it. This can be done 
at any time.  (If you are using Cash VAT Accounting, it is important to 
Allocate as many items as possible before printing a VAT Return.

In the left column enter:

Y -- YES, PAID in full (Allocate this item)

P -- to Part-allocate (then you enter the amount to part-pay)

N -- NOT PAID (ie. cancel either of the above)

Transactions     |       47



It is this process that alters the Amount Outstanding 
Field in the history/statements. When the outstanding 
amount is zero; an item is considered paid. You can 
also part-pay an item. If this Supplier Record has 
the Option set as Brought Forward the computer will 
automatically allocate any money against the oldest 
invoices during the next Month End.

As you Allocate each item, the Allocated TOTAL will change. We 
recommend you begin by allocating any money, credit notes and discounts. 
These all will decrease the Allocated Total. Now start allocating invoices 
and any Balances Forward  this will increase the Total.  Stop when the Total 
gets back to zero (ie. an exact match between money and invoices).

If you select SAVE when the  Allocated Total is not zero, ABC will query 
this, and offer you several alternatives to get rid of the discrepancy:

STORE B/F --  create a new Brought Forward item.

WRITE-OFF -- (as a Discount)  useful for small amounts, eg. if you paid 
three pence too much by mistake, this allows you to get rid of it

ALLOCATE -- go back and try again.

EDIT -- go back and change the money amount.

Arbitrary payment
If you wish to make an arbitrary payment to a Supplier, just enter this on 
the Money Details tab page and then SAVE.  You can Allocate it at another 
time.

Print Remittance Advice or Cheque
You can print either of these at this stage. You cannot come back later and 
print them. 

If the printout does not match your stationery, it can be 
customised to suit. 
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Details of the payment

The following fields must be completed:

Field  Description

Amount Paid The amount of money paid to the supplier.

Method of Payment In what form was the money? page 106

Date of this transaction We suggest the date is within the current 
bookkeeping month.  page 105

Paid from Heading Specify the Analysis Heading from where 
this money will be paid. It must be one of 
your Bank Headings. page 105

Our Reference This might be your cheque number

Note A brief comment about this transaction. Can 
be left blank.
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Discount
If you tick the ALLOW DISCOUNT box, additional Fields appear to allow 
you to enter and calculate a Settlement Discount for this payment. 

The Suppliers account balance will be reduced by the Amount of money 
you are paying, plus the discount. 

Field  Description

Amount Paid The actual amount of money that you pay to 
the Supplier.

Discount percentage ABC displays this automatically.

Discount You can enter an amount here; or enter a 
percentage (eg 3%)

Total ABC calculates this figure automatically. This 
is the amount by which the Supplier account 
balance will be reduced. You can choose to 
fix this total (play about with the above two 
Fields to get the total to what you require and 
then tick the FREEZE box) and then adjust the 
Amount Paid and Discount.

Refund from a Supplier
If you need to enter a Refund from a Supplier, enter it as a payment but as a 
negative amount, eg. -18.73

You cancel (stop) a cheque to a Supplier
Enter it as an arbitrary payment as described above but enter the amount of 
the cheque as negative, eg. -35.12

Contra payments
If you owe money to a Supplier, and they also owe you some money, you 
can avoid both having to raise cheques by simply cancelling your invoice 
against theirs (obviously they must also agree to this). This is known as 
paying by contra. 

You should enter both the Sales and Purchase sides of this transaction 
at the same time, and the amount must be the same in both cases. (If the 
invoice on either side is of a greater value, then just mark it part paid by the 
smaller amount).

Use the special Heading 8395 for all Contra Payments.

50	 |	 ABC6 User Manual



B. Cash Payments (ie. not “credit”)
These are small miscellaneous purchases (by cash, credit card, cheques, 
etc) for example buying petrol, stamps, stationery at the local shop, paying 
the window cleaner.   You would also use this CashBook for entering details 
of paying your VAT Return, proprietor drawings, cashing a cheque to put 
money in the Petty Cash Tin, and paying Wages to employees (and Tax/NI to 
the Inland Revenue).

You can enter a batch of transactions (or just one) and then post these to the 
accounts immediately. Or you could store the batch, and continue entering 
at a later time (may be useful to let someone else check the entries before 
they are made final). You can print the batch of entries on paper, before or 
after finalising them; and you can recall the previous batch of entries to 
view or print.

Cashbook > Cash Payments
You can switch between the previous batch and the current batch of entries. 
When you finalise the current batch it is posted the accounts and becomes 
the previous batch.  Only the current batch can be edited.

ABC generates a CashBook Folio Number (eg CB001234) for each item that 
you enter. We recommend you write the Folio Number onto each receipt 
or bit of paper as you enter them into ABC -- this makes it easy to cross-
reference from the Audit Trail later. 

The following Fields must be completed for each line.

Field  Description

Date The date must be within this bookkeeping 
month or a future month. page 107

Analysis Heading What was this amount for? Enter an Analysis 
Heading CODE.  page 107

Note Imagine you are looking at a list in six months 
time and trying to remember what this entry 
was for. The note will appear on the list; try to 
type something useful (example... Employee 
name, description of item, reference number, 
etc).

Reference For your own use. Some useful reference. For 
example; the Cheque number. Or your initials.

Amount Enter the total amount (including VAT).

VAT Code The VAT Code for this transaction.    page 108 
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VAT Amount Enter the Amount of VAT. 
 
VAT Calculation: With the cursor in the 
VAT Amount field; you can press F8 and the 
computer will calculate the VAT amount for you 
as specified by the VAT CODE.

Bank Heading Where did the  money come from? Petty Cash 
Tin? Cheque from Bank? Credit card? page 107

As you complete each line, the amounts are added to the Batch Total at the 
bottom of the screen. You can edit any entries you have just made. 

You can save your work and resume tomorrow, or finalise the batch 
immediately. 

The Summary Tab Page shows an analysis of the Headings you have used, 
and the VAT split. You can print a Batch Report at the end. Many people 
find it useful to print this list of what they have just entered, and store it in 
a ring-binder with the bits of paper (receipts) to form your Petty Cash Book.

Wages payments to staff; VAT or tax to Inland Revenue
Payments that you make to staff (paying wages), and payments to the 
government (paying tax and NI, and VAT Returns) should be entered as 
CashBook > Cash Payments. These are all VAT Code “N”.

Direct Debits/Bank Charges
Enter these and tick them off on your bank statement (to ensure you don’t 
enter them twice). Use CashBook > Cash Payments for these items.

Accountants only seem to believe bank statements, so most prefer you 
to enter these items only after you see them in black and white on the 
statement. This may cause you to be a month behind in entering these 
items.  Check with your accountant -- we think they will still prefer this.

Standing Orders
You can store a list of regular transactions. Typically each month you call 
up the list and tick those items you wish to process (post to the accounts). 
ABC will stop you accidentally posting the same item twice in a month. 

CashBook > Standing Orders
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Internal adjustments/movements
These transactions take place within your business, ie. they are internal. 
For example, getting money from your bank to put in your petty cash tin, or 
making a correction for analysing an expense against the wrong Heading. In 
all these cases the VAT Code is N (Not Applicable).

Transfers (Nominal Journal direct entries) should be the last resort  -- use 
these only if you cannot find a better way of entering a transaction.

Bankings
Most of the money you receive (entered using Money Received in Sales 
Ledger) is normally posted to the MONEY ON PREMISES Heading.  It 
remains there until you use BANKINGS to transfer it to the bank. You 
should use the figures from your bank paying-in book to enter BANKINGS; 
and put the bank paying-in book reference as the Note.

When you select BANKINGS, the screen will contain the following items on 
each line. Generally you only enter a single figure for each type of money 
(eg. total of cheques, total of cash). 

The reason for this procedure is to make the computer Bank Report agree 
exactly with your real bank statement, for easy reconciliation.

Cashbook > Banking
Start by selecting which Bank Account you have taken money to. Then 
enter one or more banking transactions. For each line you need to fill in the 
following columns:

Field  Description

Date Must be in current Bookkeeping Month. page 107

Note Any note or comment

Amount The total amount of this batch of items; ie. the 
amount shown on your bank paying-in slip.

BankBook The reference number from the page of your bank 
paying-in book. 

Method Type of items in this batch. eg Cheques?  page 108

ABC generates a Journal Folio Number (eg JN001234) for each line. You 
should write this on the Bank Paying-in book counterfoil, or on the bank 
statement -- it helps cross-reference from the Audit trail.
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Bank Reconciliation
This allows you to compare your real bank statement with the ABC List of 
bank transaction. Ideally they would agree exactly, but sometimes you will 
find differences -- eg. a direct debit or standing order you have not entered 
into ABC, or a cheque that didn’t get paid into the bank. These differences 
need to be “reconciled”.

CashBook > Reconcile Bank
Typically you should tick off on the bank statement and computer screen 
each item that appears on both. And then investigate any item on either list 
that is not ticked.

Start by selecting a bank account. When you have finished, it may be useful 
to print a list of unreconciled items on paper.

Writing a cheque for the petty cash tin
If you get money for the Petty Cash Tin by cashing a cheque at the bank, 
enter it here:

 Cashbook > Enter Payment

Opening Balance to Customer/Supplier
This function is normally used only when you set up a new Customer 
Record. Note that the Opening Balance is simply a total amount of money 
-- any VAT must be handled separately (page 19) For Suppliers, use the 
Purchase Ledger instead.

Sales ledger > Customers and sales entries  
    > Select customer > Opening Balance

Opening Balances (Nominal Ledger)
You can edit the Nominal Ledger Opening Balances for the current 
accounting year.

Nominal Ledger > Direct Entries > Opening Balances
After editing the Opening Balances, ABC allows the option to write these 
figures into the Headings (N/L Accounts) Records.

The Opening Balance Edit screen shows for each account (Heading) 
whether it is a Credit or a Debit account, but you do not need to think 
about this when setting the opening balance figure; just set each account 
(Heading) to the opening balance figure it should be, for example set Bank 
Account 8411 to eg. £3456.12 (unless it is overdrawn in which case you 
would put a negative figure  eg  -£456.78)

You cannot exit from the Opening Balances Edit until the books are 
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balanced, ie. total Db = Total Cr.

When you run the Year End function (page 75) the Closing Balances for this 
year can be used as the Opening Balances for next year.

These opening balances are stored in a separate file and you can edit them 
without affecting your accounts. ABC will not let you exit until they are 
balanced (ie. Total Db = Total Cr). You can choose to write these figures to 
the accounts (to the Opening Balance fields of the N/L accounts.  The N/L 
current Balances are made up of the Opening Balance (at start of year) plus 
transactions for this year to date.

Transfers (Nominal Journal)
Most Bookkeeping entries will be made through the Sales/Purchase 
Ledgers or CashBook. The Nominal Ledger Journal should only be used for 
those few adjustments or corrections that need to be made directly to the 
Headings (N/L Accounts). We suggest you do not use Transfers unless you 
cannot find any other way.

Examples of Transfers
Make adjustment required by Special VAT Scheme 
Transfer money from current account to deposit account 
Adjust Prepayments, Accruals, Depreciation 
Correction of mistakes.

Nominal Ledger > Direct Entries > Journal (Transfers)
Each line is one complete balanced entry; the transfer of an amount from 
one Heading (N/L account) to another. You need to fill in the following 
columns.

Field  Description

Date  Must be in current Bookkeeping Month.    page 107

1st Heading  The Heading you are adjusting.                  page 107

Adjustment  The amount of this adjustment. You can put a 
positive or a negative amount. A positive amount 
will increase the Heading’s balance. Do not worry 
about “Debit” or “Credit” -- ABC takes care of all 
that.

Note  Any comment or description of this entry.

2nd Heading  The balancing Heading. You are Transferring an 
amount from one Heading to another -- this is 
the other. ABC takes care of Debit and Credit and 
ensures everything stays balanced. page 107
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The Summary Tab Page shows the effect of this batch of entries.

VAT normally is not involved in Transfers, because all you are doing is 
making internal adjustments within your business. 

The expressions Increase or Decrease the Analysis 
Heading are translated by the computer to 
automatically Debit a Debit Heading (for increase) or 
Credit a Credit Heading (increase). Entering a negative 
amount to Adjust a Heading will Credit a Debit 
Heading, or Debit a Credit Heading. 

Wages Summary
The calculations for wages must be done as a completely separate task, 
usually using the Inland Revenue calculator or a Payroll System (eg. the 
ABC Payroll). The summary can then be entered to ABC Accounts here:

 Nominal Ledger > Direct Entries  > Wages Summary
This posts the total liability to the Balance Sheet (Heading 9221) after you 
enter details of the wages, tax and NI totals.The totals are what you owe (to 
the government and to employees.

When you come to actually pay money to these people, use the normal 
CashBook > Cash Payments for the individual payments (the Analysis 
Heading for those should be 9221). (page 107)

A good solution is to get the ABC Payroll Module. Not 
only does it do the calculations and produce all the 
paperwork, but it can automatically make the postings 
to the ABC Accounts system, and send the RTI data to 
HMRC website.

Stock Value
ABC will display the computer’s value of your stock and you can enter a 
New Value. Usually this should be based on a Stock Valuation report. This 
figure can affect your Profit & Loss and Balance Sheet (and your accountant 
may adjust the value for various reasons).

Nominal Ledger > Direct Entries > Stock Value
This entry will write the new Stock Value to Heading 8121 (Current Assets) 
and the stock movement to Heading 3981 (Cost of Sales).
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Stock (Inventory) transactions

Enter Goods In
Stock items received from suppliers.

Select Stock Record > Stock In

When entering Unpaid Bills (Purchase Ledger) you can 
at the same time update stock quantities from there. 
(page 57) 
 

Enter Goods Out
Items you are taking out of stock for some reason (if you use Stock Codes 
on Sales Invoices, those items are automatically taken out of stock by the 
invoicing system).

Select Stock Record > Stock Out

Enter Stock Adjustments
After completing a Stock Take, you might find the actual number of some 
items in stock is different to the computer figure. Use this function to 
correct the computer by entering adjustments. (page 38) 

Select Stock Record > click on ADJUST tab Page
This function might also be used to enter Stock Opening Balances.

The Purchase Order system (optional extra module) can 
update the Stock automatically as Orders are received 
from suppliers. 
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Unpaid bills (purchase invoices)
Find the Supplier Record  >  Unpaid Bill

If you do not already have a Supplier Record for this Supplier, you can Add 
one at the same time (page 26)

Enter the following details from the Supplier invoice: 

Field  Description

Invoice Number. The invoice number from the unpaid bill.

Date on the Unpaid Bill The date as shown on the unpaid bill. If it 
is in a previous bookkeeping month, ABC 
will leave the date as a note, but store the 
transaction in the current month.

Our Description  A few words to describe this purchase. 

Invoice Total The total amount as shown on the unpaid 
bill. (including any VAT).

Amount of VAT If this unpaid bill includes any VAT; you 
must enter the exact figure that is shown 
on the bill (even if the Supplier got their 
calculations wrong; you must still enter 
their figures).

Their Account number If the unpaid bill shows an Account 
number that the Supplier uses for our 
company; then you can enter this here (it 
will then be shown on any Statement or 
Remittance advice).

Now analyse the invoice total against one or more Headings, on the 
Analysis Tab Page. The following columns must be completed:

Field  Description

Analysis 
Heading Code

Normally will be a Cost of Sales (3000 ) 
or Expense Heading (4000)                   page 107

Description A few words to describe this line.

VAT Code Amount excluding VAT The amount (excluding 
VAT) for this line Shortcut: If you leave the 
Amount blank ABC will fill in the remaining 
amount.

Often you may just analyse the item against one Heading, but up to 99 
Headings could be used.
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Before you can finish, the Goods Total shown at the bottom of the window 
must agree with the figures you entered on the Invoice Summary tab page. 

ABC generates a Folio number for the Unpaid Bill; you should write this 
number on the invoice. It is a good idea to use a special colour pen for this 
to allow you to see immediately if an invoice has already been entered.

Debit Notes
(a Credit Note received from a Supplier) Treat exactly as an unpaid bill, but 
enter the Amounts as negative.

VAT-only Invoice
Sometimes you may have to enter an Unpaid Bill that contains only VAT. In 
this case the Invoice Total will be the same figure as the VAT amount. You 
still need to analyse this against a purchase Heading, but it doesn’t really 
matter which one since the goods amount is zero. Put VAT Code 1.

To indicate to ABC that this is a special VAT-Only Invoice, tick the box on 
the ribbonbar.

Update Stock
You can update your stock quantities while entering the unpaid bill. Tick 
the box on the ribbonbar to cause the additional stock columns to appear. 
(or untick the box if you do not wish to use this facility. Various options are 
available to control how ABC calculates Stock Value.  
       Accounts Utilities > Edit Company Parameters > Stock.
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Sales Invoices
ABC includes a full invoicing module (linked to the Stock System).

Sales Ledger > Customer Records > find Customer > Invoice
Invoices can have your choice of logo (small picture) printed at the top, and 
if you want to print a Message (eg. Special Offers this week) at the bottom 
of the invoice, a choice of attention grabbing borders can be used.

All invoices begin as “ProForma Invoices” and can be stored or printed 
part-finished. The Options tab Page allows you to print as Delivery Note, 
Estimate, Quotation, etc. ProFormas do not affect the accounts -- they can 
be edited or deleted. You can have several ProFormas for one customer. 
ProFormas are given a Folio number starting with PF.

Select FINALISE to convert the ProForma into a real Invoice and write it to 
the accounts files. A finalised Invoice cannot be changed any more -- but 
you can reprint it at any time (page 29). Finalised Invoice Folio numbers 
begin with SL.

If you currently have some part-finished or proforma Invoices for this 
Customer you can select one of those, or create a new invoice

The Invoice Top contains these Fields

Field  Description

Account number  
Invoice number

The computer fills these items into the 
invoice and you cannot alter them here.

Invoice Date This is the tax point for VAT. It must be 
in the current (or a future) bookkeeping 
month.

Supply Date Useful as a note, for example the date 
when the goods were supplied. Can be left 
blank. 

Your Ref. Any note (eg. Order Number or a name). 
Can be left blank. This will be printed on 
the Daybook. If you entered anything in 
the NOTE Field on this customer Record; 
it will appear here by default.

Our Ref Any note or reference (eg. Delivery Note 
nbr.) or can be left blank. This will be 
printed on Daybook.

Trans. Type Any brief note. Can be blank. 

Sold By Initials of salesperson; or any note. Can be 
blank.
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Delivery Ref. Any note, for example the method of 
delivery, or our Delivery Note Number. 
Can be left blank.

Delivery Address Defaults to same as invoice address. You 
can enter any different address here, or 
leave it blank. Or click the button to select 
or edit a stored Delivery Address for this 
Customer.

Special Instructions Can be left blank, or you can enter any 
notes or instructions as required. If you do 
enter a message here, you can enhance it 
by printing an attention grabbing border 
-- see the Message Border tab.

Notes Any further notes or instructions.

Special Invoice types
You can modify the behaviour of an invoice in several ways, for example:

Cash-with-Order Invoice (if the invoice is being paid immediately). This 
is just a short-cut to save you having to separately go and mark the 
invoice paid later.

VAT-inclusive Prices. Instead of entering net price, and letting ABC add 
on the VAT, the VAT-Inclusive Invoice takes the prices you enter as 
already containing VAT; ABC will then automatically separate the 
VAT and show it on the invoice.

VAT-only Invoice. Not a common requirement for most businesses, but 
some companies need these (eg.import/export agent). This is an 
invoice with zero value of goods, but an amount of VAT. 

1. The VAT-only option will override any other special 
invoice selections. 
 
2. Only the first line can be used, and the Amount is 
taken to be the VAT (and put against VAT rate 1)

Invoice at Zero VAT rate. For certain categories of customers only.

Used Car special VAT scheme. If your business includes selling used cars 
you can print customer invoices that do not show the VAT (which 
will be calculated on the difference between cost and sales price.

To specify one of these special types, see the OPTIONS tab page.
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Delivery Address
ABC allows you to store multiple delivery addresses for any customer. Click 
the Delivery Address button on the Invoice Top/Bottom to view/edit/add 
addresses. 

Customer Reference
Several Fields from the Customer Record will be filled into the Invoice Top. 
You can also use the last stored Invoice Top for this Customer as the basis of 
the new Invoice -- see Options tab page.

Body of the Invoice
The body of the invoice can contain up to 198 lines.

Some lines may contain just descriptive text, and you can leave blank lines 
between items if you wish (to make invoice prettier).

To make the invoice lines deeper, drag the line down 
at the left hand edge of the Invoice. This lets you have 
long item descriptions. 
 

Use the mouse or cursor keys to move to the line you wish to change then, 
to edit the line, double click, or press ENTER, or click EDIT.

Each line contains the following Fields.

Field  Description

Quantity The number of these items you have sold.

Stock Ref. A Stock Code. Enter ? to select from Stock File. 
Leave blank if you don’t want an item from Stock.

Description Enter a description of this item. If you have used a 
Stock Code; ABC can fill in the Stock Description 
here.

Unit Price Enter the unit price of this item (excluding VAT 
unless you are working with VAT-inclusive prices).

Discount You can enter a trade discount that applies to this 
line only. Either enter a figure; or a percentage (eg 
3%). This discount can be positive or negative (ie. a 
surcharge).
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Amount The net amount for this line (ie. excluding VAT 
unless you are working with VAT-inclusive prices). 
ABC can calculate this from the Quantity, Unit Price 
and Discount.

VAT Code Enter the CODE to specify which rate of VAT applies 
to this entry line.  page 108

Heading code Enter an Analysis Heading Code.  page 107

ABC will check each line and alert you to any problems. You cannot Finish 
the line until you correct any errors.

While entering the lines you can right-click the mouse for editing functions 
including Copy, Insert, Cut, Clear, or Paste lines.  

When you have finished editing the invoice you have the options to print 
a ProForma Invoice, Hold the Invoice (store on disk as a part-finished 
Invoice), or Finalise the Invoice). The invoice can be edited or deleted at 
any time until you Finalise it -- thereafter it cannot be changed. (It only gets 
posted to the accounts when it is finalised).

Print the Invoice
A Part-finished Invoice can be printed as a Proforma Invoice. The proper 
invoice can only be printed after it has been finalised. It is possible to 
reprint old invoices at any time (page 29).

If you are entering details of hand-written invoices you may choose not to 
print anything. Invoices can be emailed, or printed on a dot-matrix printer  
using a Text-Only Layout that you can easily customise -- page 116. 

Delivery Advice Note/Estimate/Quotation
You can print any of these items by selecting from the Options tab page. 
These are copies of the invoice but you can choose the words printed at the 
top, and whether or not to show prices.

Credit Notes
Create an invoice as normal but arrange that the final total is negative. This 
can be done either:

a) by entering a negative price and no stock code. This will not affect the 
Stock File

b) by entering a stock code and putting the quantity negative. This will 
put the items back into the Stock File (eg. if the Credit Note is for 
goods returned to you).
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When this negative invoice is printed, the words CREDIT NOTE will appear 
instead of INVOICE.

Settlement Discount
If you have ticked the Settlement Discount box (Customer Record -- Options 
tab page) then the settlement discount terms will be printed on the invoice. 
For example, 2% discount for payment within 7 days. 

Link to the Stock File
You can call a description and price from the Stock File. This saves you 
typing the information, and of course ensures the price is right. You will 
find this useful even if you don’t need Stock Control at all, as you can store 
lines of text that you often use on invoices -- Page 34.

Enter a Stock Code on the Invoice (or select from the drop down list) and 
ABC will fill in the description, price, VAT Code and Analysis Heading 
from the Stock Record.

If you have entered a Quantity, then it will be deducted from the Quantity 
in Stock Field on the Stock Record Card.

Picture (company logo) on Invoice
To make your invoices look more professional and businesslike, you can 
print your company logo (or any small picture) at the top. You can change 
the picture or turn off this function on the Options tab page.

Message with border
You can print an attention-grabbing border around your message at the foot 
of the invoice. The Message Border tab has several choices, including No 
Border. If you do not enter any text in the Special Instructions box on the 
Invoice Top/Bottom, then no border will be printed anyway.

Corrections and Adjustments
In general, you should always make any corrections or adjustments by 
creating a new transaction. From experience we have found this is the best 
and safe way to keep Accountants and Tax Inspectors happy, and to make it 
clear what you have done.

For example, if you invoice the wrong company or for the wrong amount 
you can correct the situation most neatly by creating a Credit Note to cancel 
the incorrect invoice. In the Reference Field of the Credit Note put the 
Invoice Number of the original invoice. And then start the invoice again.
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5
Printing reports
Viewing lists, labels, summaries  
on screen, paper, or to disk file

When you select any Report in ABC, it is displayed on screen in the 
Preview Window (page 114).  This allows you to check the contents; zoom 
in or out, and move from page to page. Select PRINT if you need to send 
the report to paper, and you can then select a printer and maybe a range of 
pages. Or select EMAIL to attach this report as a PDF to an email.

It is also possible to export Reports to a disk file, for example in PDF, CSV or 
HTML format for use in other applications, websites or email.  
Select EXPORT > PDF, CSV, etc.

Sales Invoices and Statements have an additional option to allow you to 
email them directly, or to send to a dot-matrix printer (eg. for multi-part ncr 
sets) using Text-Only print layouts that you can easily customise to your 
own requirements -- page 115. 

Reports can be viewed or printed at any time, and as often as you wish. 
Plain paper is used for all printouts.

Most reports can be customised by setting options (page 114) to choose 
a range of dates, sorted order, and other criteria. ABC can be set to 
automatically print your choice of reports each Month and Year End.

In addition to the built-in bookkeeping reports, you can design your own 
reports and labels to print information from the Accounts files or your own 
files.

This chapter lists all the built-in bookkeeping reports, with a few notes 
pointing out any unusual features or options.

We do keep adding more reports to ABC in response to user requests, so 
your copy of ABC may include extra reports not mentioned in this manual.
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Sales (Customer) reports
You can select the following reports from the Sales Ledger Menu.

List Customers A list of Customers showing their company name,  
address, telephone number, etc 

Customer 
Statements

Normally you print Statements to send Customers 
a reminder of unpaid items but it may be useful 
to also show items they have paid recently. ABC 
options allow you to choose what to show on 
the Statement, and who to send Statements to. 
Typically you would produce Statements at the 
end of each month. Also note: While looking at a 
Customer Record Card you could produce a quick 
Statement by clicking the ribbonbar button.

Customer 
History

Lists all transactions. Choose a range of dates and 
whether to expand invoices to show full details or 
just show invoice totals. Also note: While looking at 
a Customer Record Card you could produce a quick 
History by clicking the ribbonbar button..

Aged Debtors List of everything currently owing to you, divided 
into several age ranges. Telephone numbers are 
printed making this a convenient list for chasing 
overdue debts. “Future” items are not yet due. 
There’s an option to show all invoice details.

Money 
Received

A list of all money received in payment of sales 
invoices. (Reminder that CashBook income -- eg 
sundry cash sales-- are not included in this report 
but can be found in CashBook Receipts page 72).

Sales Daybook List all invoices and credit notes.  This is one of the 
basic reports required by your accountant and VAT 
Inspector.

Sales Audit 
Trail

Like an expanded version of the Sales Daybook but 
the Audit Trail also shows every line from each 
sales invoice (you can select the range of dates). It is 
mainly useful for tracking errors or auditing.

Unpaid 
Invoices

A list of invoices not yet marked as paid (as of 
today’s date). To mark an invoice as paid you 
Allocate money (or Credit Notes) against the 
invoice. (page 43)

ProForma 
Invoices

A list of ProFormas (uncompleted invoices). These 
do not affect the accounts until “Finalised”.
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Reprint (or view) old Sales Invoice (Zoom)
On the Customer’s Record Card right click on the old invoice and select 
ZOOM (or reprint). First set the grid to show History. 

Letter, Label, or Envelope for one Customer
At the Customer’s Record Card click a button on the ribbonbar. ABC can 
then automatically fill-in their address on the label, envelope or letter. You 
can edit these items and customise them with your own logo or picture

Letters or Labels for a group of Customers
Use TYPING > MAIL-MERGE (page 93) to print letters.  
Use FILING > LABELS (page 87) to print sheets of labels.

Purchase (Supplier) Reports
You can select the following reports from the Purchase Ledger Menu.

List of 
Suppliers

A list of your Supplier’s company name address 
telephone number etc. 

Supplier 
Statements

List all outstanding items for each Supplier. Also 
note: While looking at a Supplier Record Card you 
could produce a quick Statement from the ribbonbar.

Supplier 
History

The Supplier History Report lists all transactions and 
you can choose several options. Also note: While 
looking at a Supplier Record Card you could produce 
a quick History from the ribbonbar.

Aged 
Creditors

List everything you currently owe, divided into 
several age ranges. Future items are those not yet due 
for payment.

Money Paid A list of all money paid against Purchase Invoices 
(Unpaid Bills). You can specify a range of dates.  (This 
report does not include any petty cash payments 
made through the CashBook. Those are shown in 
CashBook Payments report -- page 72.

Purchase 
Daybook

A list of all Unpaid Bills (Purchase Invoices) and 
Debit Notes entered during the range of dates you 
specify. This is one of the basic reports required by 
your accountant and VAT Inspector.
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Purchase 
Audit Trail

Like an expanded version of the Daybook, but the 
Audit Trail also shows every line from each Purchase 
Invoice -- you can specify a range of dates. Mainly 
useful for tracking errors or auditing.

Bills still 
unpaid

List of items not yet marked as paid (as of today’s 
date). To mark an invoice as paid you Allocate money 
(or Debit Notes) against the invoice.

Purchase 
Orders

List of Purchase Orders showing status and total 
value.   
*** Only if you have the optional Purchase Order 
module ***

Zoom (view or print) an old Unpaid Bill
At the Supplier’s Record Card right-click on an old invoice and select 
ZOOM (to view or reprint)

Letter, Label, or Envelope for one Supplier
At the Supplier’s Record Card click a button on the ribbonbar. ABC can 
then automatically fill-in their address on the label, envelope or letter. You 
can edit these items and customise them with your own logo or picture. 

Letter or Label for a group of Suppliers
Use TYPING (MAIL-MERGE) (page 93)  
Use FILING (LABELS) (page 87)
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Stock Reports
You can select the following reports from the Stock System Menu.

You can use the stock File to store bits of useful text 
which can be called up when invoicing to save you 
time and typing effort. These text-only Stock Records 
will not appear in the following reports. (page 34) 

Stock List List of all your stock items showing their 
location quantity in stock on order and 
allocated and price.

Stock Valuation List all stock items showing the quantity in 
stock and the cost price. These figures are 
multiplied together to get the value of that 
stock item and at the end of the report the 
total value is shown. It is a good idea to print 
this report at the end of each month and then 
enter the stock value into the Accounts.

Blank Stock List List of all stock items showing the quantity 
that the computer thinks you have in stock 
with a blank space for you to enter the 
actual figure.  Print this list whenever you 
need to check your stock figures (stock-
taking or inventory). By using this list you 
will ensure that you do not overlook any 
stock items. When you have completed the 
stock-take, compare the computer stock 
quantities with the actual figure and enter 
any ADJUSTMENTS into the computer. 

Stock Sales Shows how many of each Stock item have 
been sold this month this year and the 
average per month. This is a useful guide to 
help estimate what minimum stock levels 
and re-order quantities should be, and see 
which items are selling well.

Price List List of all Stock item descriptions and selling 
prices. Prices are shown with and without 
VAT, and the price list can be printed for 
Price Group 1, 2, or 3.
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Picture Price List Prints a Price List with pictures of the Stock 
Items.

Stock Audit Trail Full Audit Trail of all stock movements in or 
out for the range of dates you specify.

Needing Re-Order Shows items where the Quantity in Stock 
is below the Minimum Stock. Re-order 
Quantity is calculated using:  
Reorder Qty = Reorder Qty  
                    + Allocated Qty – Qty on Order. 

Nominal Ledger reports
You can select the following reports from the Nominal Ledger Menu.

List of 
Headings

Also called the Chart of Accounts. A list of all 
your Analysis Headings showing the Analysis 
Code and the type of each Heading (ie Debit or 
Credit). It also shows the overall structure of 
the way you are analysing your business. Your 
accountant will find it useful to keep this handy 
when checking other Bookkeeping reports.

Trading (P&L) Also called the Profit & Loss Report. This shows 
all Sales Purchases and Expenses during this 
period and then a calculation of your Gross Profit 
and Net Profit. Can give you an overall picture 
of the business and an idea as to which parts are 
making money and where you are spending most 
money. You can alter the layout of this report by 
changing the sub-title and sub-total Headings.

Trial Balance Lists all Nominal Accounts with their current 
balances. The total of debit accounts should be 
the same as the credit account total if your books 
are in balance.

Balance Sheet This produces a working Balance Sheet. If you are 
an expert at accounting and have entered pre-
payments, accruals, depreciation, etc into ABC 
then this report could form the basis of the Final 
Balance Sheet for a small business. 
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Heading 
History

You can specify a range of dates and Headings, 
and how you want the items sorted. The report 
will show all entries in that range, grouped by 
Heading, and showing any VAT. .

Audit Trail This is simply a list of all transactions. This is 
mainly useful for error checking. 

Bank 
Reconciliation

Can be printed from the Bank Reconciliation 
function (page 54).

VAT 100 Report (VAT Return)
You can print a VAT Return for any range 
of previous months, and choose normal 
or cash VAT Accounting. You should 
print this report after doing the Month 
End for the last month in your VAT 
quarter.

Nominal Ledger > VAT Reporting 
System > VAT Return

The options Tab Page allows you to 
specify the range of months, and also to 
choose whether to include a VAT Audit 
and a list of unpaid Sales and Purchase 
invoices (with CashVAT Accounting, the 
VAT on unpaid invoices is not yet due.)

If the end of a VAT period does not coincide with the 
end of your accounting year we recommend you ask 
your local VAT office to adjust your VAT period so it 
does match your bookkeeping periods. Check with 
your accountant of course, but it makes life easier for 
everyone and avoids extra calculations at year end.

All businesses must submit their VAT Returns Online. ABC has got HMRC 
approval to do this. Before using the Online function from the VAT Report 
tab, you must view your VAT Return on screen and check that the figures 
appear correct (you should have a rough idea of the total sales, total 
purchases, etc month by month) before proceeding. 

The first time you use this Online function, you will need to enter your VAT 
Office reference and password (obtained from HMRC). 

ABC Allows for the Annual Accounting Scheme. If necessary you can enter 
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any AAS Balancing amount before submitting your Online Return. If you 
are on normal Monthly or Quarterly VAT, you can ignore the AAS box.

After submitting your Online VAT return, ABC will display the reply from 
HMRC VAT Office. You should print this reply and file it with your books.

VAT Audit
This report lists all transactions involving VAT. 

Nominal Ledger > VAT Reporting System > Full VAT Audit Trail

Special VAT Schemes
Some VAT Schemes require an adjustment to your accounts at the end of 
the VAT quarter. You must enter this adjustment (using Nominal Ledger 
Transfers), and ensure that you only enter it once.

CashBook Reports
You can select the following reports from the CashBook Menu.

CashBook Sales You can specify a range of dates and this report 
will list all CashBook Receipts (eg. sundry sales) 
entered during this period.

CashBook 
Payments

This could form your Petty Cash DayBook. 
Specify a range of dates and this report will list all 
CashBook Payments made during this time.

CashBook Bank 
report

A list of all Bankings entered during the range of 
dates you specify. Each bank account is shown 
separately.  This report should contain the same 
items as the bank Statement you receive from your 
bank -- making it easy to compare the two looking 
for errors and omissions.

Bank Statement Similar to your real bank statement this report 
shows a list of all Receipts/Payments to a bank.

Design your own Reports or Labels
Use FILING to design your own reports or labels to print data from the 
Accounts files. This will not affect the accounts data. page 86.
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6
Month & Year End

Closing each Month 
Closing the accounts Year

General Notes
At the end of each month you must use the Month/Year End function to 
close your accounts for this month and set the current bookkeeping month 
to the next month. 

NOTE: When you get to the end of your Accounting Year, ABC will 
automatically also run the Year End as well as the Month End..

Run the Month End
Accounts Utilities > Month/Year End

Once you have got used to the system you might find it helpful to draw up 
your own Month End Check List and tick off each item as you do it.  Here is 
an example:

                       Month End Check List
RR Enter all petty cash purchases

RR Enter all bankings

RR Enter Standing Orders, direct debits, from the bank statement.

RR Look through bank paying-in book to ensure all cheques have been 
entered and invoices marked paid

RR Check that you’ve entered any PayPal, Amazon, or eBay costs as well 
as any sales or purchase transactions.

RR Print Customer statements
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Hints & Tips
ABC will encourage you to make a Snapshot or Backup at Month End.

Before doing the Month End you normally should check that you have 
entered all the petty cash purchases, bankings, standing orders, etc. If you 
have any online transactions or PayPal purchases, remember to enter these 
as well. And with online trading (eBay, Amazon, PayPal, etc) you may need 
to log-in to your account online and download a full list of all the charges.

Many people wait a few days after the end of a calendar month before 
doing the ABC Month End, to allow for late arriving Purchase invoices to 
be entered. This is OK, but we suggest you do not wait too long -- 7 days 
should be ample. Anything that arrives after that can be posted into the 
following month accounts.

If you print Customer Statements just before you do the Month End, you 
will get different results than if you print them just after Month End (ie. 
when all transactions are then shown as being another month old). Decide 
which suits you best.

You can set ABC to automatically print a selection of reports on paper 
as part of the Month End process. (These days many people do not print 
anything at all on paper at Month End. ABC allows you to print reports 
later, as required, and you could store  them to disk as PDF files which can 
be printed anytime if required.  The exceptions are Balance Sheet, Profit & 
Loss, and Aged Debtors/Creditors -- these cannot easily be reprinted later, so 
do print them at Month End if you need them).
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At the end of year
If this is the last month of your financial year ABC will automatically do the 
Year End as well.

This moves This Year figures into the Last Year boxes, and sets This Year 
totals to zero. In the Analysis Headings, the Trading Accounts are set to 
zero, and the Profit/Loss for the year is carried into the Balance Sheet (you 
might adjust this later when your accountant gives you his figures).

As part of the Year End process, you should print certain reports on paper 
that cannot be printed at any other time. These include:

Trial Balance

Profit & Loss (Trading) report

Balance Sheet

Aged Debtors/Credits reports

Hints and Tips
Take a copy of the Letter to the Accountant (page 76) with your books when 
you take them to your accountant. 

Your accountant does not need to go near the computer in order to audit 
your books, or prepare your Balance Sheet and end of year results. 
However, we have often supplied accountants with a copy of ABC so they 
can receive your books on a USB stick or flash drive.  
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Letter to the Accountant
Dear Accountant,

The ABC Accounts software is mainly a bookkeeping system intended 
to make life easy for a small-business owner who does not understand 
accounting.

Throughout the package we have tried to use non-accounting words. For 
example, instead of Nominal Account we have used the term analysis 
heading. Similarly, the operator does not need to know anything about debit 
and credit; the computer takes care of this side of things, and always keeps 
the books balanced.

We even suggest that if the operator has no idea about accounting they 
can virtually ignore the balance sheet and just take care of the trading side 
of the business; ie. invoicing, paying bills, sending statements, entering 
receipts and payments. The more complicated balance sheet side can be left 
to you, the accountant.

A likely scenario is that the user will have entered everything into ABC 
during the year, but that the opening Balance figures have probably not 
been set -- the result being that the computer Balance Sheet and Trial 
Balance totals will need adjustment. (ABC is a full double-entry accounts 
system, and in the hands of a knowledgeable person it could produce final 
accounts).

ABC can print a wide range of Daybooks, Audit Trails, Money Paid/
Received, and other reports. Most of these can be produced for a range 
of dates (eg. the whole accounting year, or a particular few days), and a 
range of Headings (ie. nominal expense codes). ABC retains accounts data 
for previous years, so you can ask the user to print out (for example), all 
telephone expenses for last year, or proprietor drawings during January-
March two year’s ago.

Tell the user what you need. If they need assistance to find it, they will ask 
us.  If you request something that ABC cannot produce -- we will work to 
very quickly enhance the software so that it can do it.

It is likely you will need to work out depreciation, prepayments, stock 
adjustments, etc. You may give these adjustments to the user to enter into 
their ABC Accounts, to bring the computer into line with your real world 
figures.

If you’d like to discuss this further, or suggest any improvements for this 
Accounts Package, please contact us 

        Email:  enquiries@abc6.co.uk 
        Website: www.abc6.co.uk   
        (full technical specification of ABC can be found on the website)
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7
Customise ABC

Edit company parameters, 
Extra Companies, Passwords 

Screen Colours, Font sizes

This Chapter describes how to set your own Passwords, create or delete 
additional sets of accounts (you can run more than one business with this 
copy of ABC), edit your Company Address details, and specify the next 
Invoice Number or other Folio numbers. You can also customise the way 
ABC looks on screen. See also our Newsletters and User Forum for ideas.

Edit Company Parameters
Accounts Utilities > Edit Company Parameters

Choose the appropriate tab to view or edit any of the following:

Company name and address
Fill in your company address details. These will be printed on invoices, 
reports, envelopes, etc, so check carefully.

Logo (picture) for top of reports
You can choose to print a picture (usually your company logo) at the top of 
reports. This feature can be turned off.

If you don’t have a suitable small picture file contact us 
for advice. The file should one of the following formats: 
.JPG .BMP .GIF .WMF .ICO.  Maximum filesize is 50K. 
We suggest creating the picture about 7cm wide by 
3.5cm high and about 96dpi. Store the picture in the 
ABC company data folder. eg. for Company A it will be  
\ABC6\A_DATA.
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A similar picture or logo can be printed at the top of Invoices and 
Statements. You can use the same picture for all, or choose different 
pictures. To set the Invoice or Statement logo, see the Options tab when 
printing an Invoice or Statement.

Folio & Invoice Numbers
Do not change the Invoice or Folio numbers without good reason. 
Accountants are suspicious of daybooks or audit trails that have gaps in the 
numeric sequence.

There are several sets of Folio Numbers. page 21

Accounting Year
Set the start month and end month of your accounting year.  Normally you 
would have 12 months in your accounting year, but this is not compulsory.

It is a bad idea to change the current accounting month once you have 
started using ABC. If you feel you need to do this, please contact ABC 
support to discuss it -- we usually can suggest alternatives.

View All
This tab page displays all the settings and options stored in the parameter 
file for this company in ABC. It is intended just for trouble-shooting or 
maintenance work and you cannot change anything here.

Options
Some general User Interface options. For example, experts can tell ABC not 
to require the EDIT button to be pressed before you can edit a record card.

Two different types of email system are available. MAPI is to be preferred.

During day to day use, ABC stores some non-essential data in Windows 
Registry. Occasionally something may go wrong and a non-valid setting in 
the Registry cause ABC not to work properly. The button on this page to 
CLEAR REGISTRY SETTINGS sets everything to a safe default value.

Stock
Several parameters can be set here, including the number of decimal places 
to use, and the type of New Stock Cost calculation -- eg. Last In or Weighted 
Average. (page 38)
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Passwords
You may not want everyone who walks past your computer to be able to 
view your accounts or change records. ABC can restrict access to people 
who know the correct password.

Accounts Utilities > Passwords
The Passwords tab page has a box you can tick to turn the Password System 
On or Off.  A table shows all your Passwords. 

For each line you can enter: 

Password Up to 6 characters

Note  Any note about this password (can be left blank) 

Level  1 to 9. (9 is the highest).

You can have up to 20 different passwords, and each can be set to a level 
between 1 and 9. The different levels of password allow access to various 
parts of the package as follows:

Level  Access permitted by this level

1 Cannot clear or delete files or records. Cannot access 
Bookkeeping; Payroll; or secured files.

2 Cannot delete files. Can make entries into Bookkeeping; 
but not view Profit/Loss or Bank. Cannot run Month 
end. Cannot access secured files. Cannot run Payroll.

3 Can delete files. Cannot run Month end. Cannot run 
Payroll. Can view secured files.

4 Can do most things including Month End and Payroll. 
Cannot change passwords or zero accounts; or use 
Filing to edit accounts.

9  Full access to everything; no restrictions

If you want to set the same level for all areas, just set the last column -- the 
rest of the columns will then be set to that level. At least one Password must 
be the highest level for the Utilities area (since this is necessary for editing 
the Passwords).

You can turn OFF the Password security system in ABC, and then you will 
never need to Log-In (also, anybody could view or edit your accounts files). 
Or you can set up a complicated set of different Passwords, each allowing 
access to just some areas of ABC; for example the ability to view (but not 
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change) Sales Invoices, and full access to CashBook. Note that if you allow 
someone to access FILING, this allows them to also view the Accounts files.

Each Company you set up in ABC will have its own set of Passwords.

ABC does not encrypt the data in its files. The password system is only 
to deter casual passers by using ABC to view your accounts. A computer 
expert could easily view the files directly without using ABC.

Other Companies
ABC allows you to do the bookkeeping for up to 26 different Companies, 
and we call them Company A, Company B, etc. Each will have its own 
folder on the hard disk, and there is no interaction between the different 
sets of accounts.

Accounts Utilities > Rarely used function > Other Companies
The top of the screen always shows the Company Name of the set of 
accounts you are working on. If you change any account options, or use 
Snapshot, Month End, etc, you are only affecting this one Company.

You can quickly switch to a different company (but first close down 
whatever function you are using). Just Log-Off and then when you Log-On 
you can choose which company you require.

Create new Company
You can create new companies here. The first thing you should normally do 
after creating a new company is to follow the procedure for setting up the 
accounts. page 13.

Delete a Company
Do not proceed unless you are sure. If in doubt, make a Backup first. (Not a 
Snapshot). You cannot delete Company A.

Other functions
Some other functions are provided, for example to copy accounts files from 
one company into another.

You can view a quick summary of each company

Customise the screen
Use the OPTIONS Menu (top right of screen) to change things like screen 
colours, font sizes, and visual theme (the “look” of ABC). 
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8
FILING

Create your own Files  
Design and Print Reports and labels

The Filing option on the Main Menu is a simple database and report 
generator that allows you to store and edit your own information,  and print 
lists, reports, and labels to your own design.

Filing can also be used (password permitting) on any of the ABC account 
files.

ABC stores its data in MS Access type databases. 
We refer to “files” but in MS Access they are called 
“tables”.  
 

Open a File
Filing  > Open a File

Select which database you require -- Accounts Files, Filing (your own Files). 
or any other MS Access type .MDB database. A list of Files (Tables) in that 
database is then displayed for you to select from.

You can view the Records in two different ways. Either as a Record Card 
(one Record at a time, as in older versions of ABC) or a Grid (Table), (each 
Record occupies one line).  Switch between these views at any time.

In the Record Card view you can use the Select Record functions (page 109) 
and you can click  Edit, Add or Delete on the ribbonbar. Before being 
allowed to edit an Accounts File you need to enter a special password 
(obtainable from ABC Direct Sales). After editing, choose Save or Cancel.

While using Grid View, scroll up and down, click on column headers to 
sort into order, select groups, or rearrange columns (page 112). The Grid is 
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similar to a Spreadsheet, and you can simply click in a cell and edit it (but 
with Account files, you can only do this if you have entered the password).  
Add a new Record by typing into the blank line at the top of the Grid. 

Customise a File
You can change various properties of the Record Card to make it better suit 
your requirements. This includes adding or deleting Fields, changing the 
size or type of Fields, renaming Fields, and specifying which Fields to use 
for printing address labels. You can set a Field to be “auto-number” (eg. 
useful for serial numbers) or “auto-date” (fills in today’s date whenever you 
edit the Record). 

Open the File, and then from the ribbonbar select EDIT PROPERTIES.

Take care before using this powerful function. For example if you delete a 
Field you will destroy all information contained in that Field throughout 
the File.

The properties are displayed in a Grid, and you can edit any of the details. 
With Account files, ABC will not let you change properties that are 
important to the accounts. Right-Click to Add or Delete a Field.

It might be useful to print these properties before and after changing 
anything. Click Print Record Properties on the ribbonbar (or see next 
section).

With a new file it is a good idea to set the FieldNames and FieldTypes 
BEFORE you start creating Reports and MailMerge Letters that use this File 
(Otherwise when you change a Field’s Name you need to also change every 
Report or Letter that contains this Field).

For each Field you can set these properties:

Notes

 Field Name Must be unique within this File. We also suggest 
you keep it unique within your database -- the 
easiest way to ensure this is to prefix each Name 
with an abbreviation of the File Name. eg. if the 
FIle is called Dog Club Members we’d suggest 
Field Names like dgmBREED  dgmOWNER  
dgmTELEPHONE. 

Field Length Text Fields default to 50 characters long but you 
can set a maximum length of 255.  Be generous 
with the Length for Text; it is better to set it a few 
characters bigger than too small. Numbers and 
dates are stored in compacted form so ABC may 
set the Length to the correct required value
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Field Types The default type is Text but you can set various 
other types such as Date or number (long Integer 
is a number with no decimal places). You can 
also (see table below) specify a Field to be “auto-
number” (eg to increment Membership Numbers) 
or “auto-Date” (today’s date is filled into a Record 
whenever you edit it.

Format style The default is “None” but you can specify that 
ABC formats a Field to Uppercase (capitals) or 
other style.

Order of Edit This sets the order in which Fields are displayed 
on screen in the Record Card View. The top field 
Order of Edit is 1 then 2, 3, etc.

Other properties that can be set
(ABC will have set these to a default value, but you can change them at any 
time).

Description

Unique Field If a Field will have a unique value for each Record 
in the File specify the FieldName as the Unique 
Field (ABC then uses it as an Index). For example 
the Customer File has the Account Number as the 
Unique Field.

Find Field1 
Find Field 2 
Find Field 3

Specify three Fields (enter FieldNames) you want 
to use to locate Records when you are in the 
Record Card View.

Label Line 1 
Label Line 2, 3 
etc

Specify the FieldName you want to print on line 1, 
line 2, line 3, etc of an address label or envelope.  
From now on you can simply click Print Envelope 
(or Label) and ABC will know which Fields to use.

Auto Number If you want to set a Field as “auto-number” enter 
the FieldName.  When you then ADD a new 
Record ABC will lookup the last number entered 
in this Field, increment it by 1, and fill it into this 
Field for you.

Auto Date If you want to set a Field as “auto-date” enter the 
FieldName.  When you then EDIT any Record ABC 
will fill today’s date into this Field.
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Print Record Properties
This will produce a printout of the Record Card layout showing the Fields 
(names, size, type) etc. Useful to document your Files.  

Open a File, and from the ribbonbar click  Print > Record Properties.

Design your own File
You can create new Files as needed, to your own design. The way to do 
this is to choose an existing File to copy as the basis for the new File (the 
existing File is not affected at all). ABC does have some sample Files to get 
you started. You can then customise this new File by adding or removing 
Fields, renaming Fields, etc.

Copy a File
Open the File, and then from the ribbonbar select  Tools  > Copy File

Give a name for this new File. It will be added to the same database as the 
original File (you cannot copy files into the Accounts database). 

Import or Export data
A common method of storing data in disk files is in standard ASCII 
(pronounced Ass Key) text files. Most software products can read and write 
to this type of file, so it has become a universal method of transferring 
information.

The most common format is the comma delimited ASCII file. (usually with 
a .CSV file extension). 

ABC allows you to read (import) or write (export) ASCII files in a variety of 
different formats.

Open the File, and from the ribbonbar select  Tools  > Export   (or  Import )

Import an old ABC5 File
Filing  > Create New File > Import from ABC5 

This function will read an old ABC5 file and create an equivalent new File 
in ABC6 in the Filing Database. All the records are automatically copied 
into the new File. This does not affect the old File at all.

Because ABC5 cannot provide a name for each Field, ABC6 calls them 
Field1, Field2, Field3, etc.  One of the first things we recommend you do is 
to Customise the new File (page 82) and set the Field Names to something 
meaningful (eg. CompanyName, Telephone, Postcode). It is a good idea to 
do this before you start designing reports or mailmerge letters because these 
require you to specify the Field Names. 
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Global Change
This most powerful function allows you to specify a change to a Field of the 
current File. The same change can then be performed to all (or a selected 
group of) Records in the File.

Open the File, and from the ribbonbar select   Tools > Global Change

Specify which Field you want to change and enter details of the new 
contents for the Field -- this can be a calculation.  Also decide which 
Records in the File should be affected. A SQL Wizard can help you enter 
quite complicated selection criteria.

ABC will allows you to test the change (and see how many records will be 
affected) before you finally start the Global Change in operation.

Global Change has a box you can tick if instead of changing records, you 
wish to Delete the selected records.

Clear a File
All Records are removed to leave you with an empty File. The data is 
permanently deleted, so ABC makes sure you wish to proceed.

Open the File, and from the ribbonbar select Tools > Clear File

Delete a File
The File will be completely erased from the database, and its contents 
permanently erased -- so ABC makes sure you wish to proceed..

Open the File, and from the ribbonbar select Tools > Delete File

FILING     |       85



Design your own Reports
The ABC Report Designer allows you to choose a data File, select some of 
the Fields and position them on the report layout, and specify Grouping of 
Records and Sorting Order. You can enhance the Report with a picture (eg. 
company logo), Heading and Footer, and specify various types of calculation 
to produce totals. 

Experts can edit SQL statements to select Records from 
joined Tables. ABC has a SQL Wizard to help. 
 
 

You can use the Accounts Files in your reports, giving you the ability to 
create your own accounting reports to meet your requirements. You can 
Save Reports and simply Load one when you want to print it. Reports can 
be previewed on screen, printed on paper, or sent to a PDF, HTML or Text 
File on disk.

Filing  > Report Printing
From the toolbar choose LOAD (an existing report) or NEW (create your 
own). Beginners can simply Load and Print a report that may have been 
created by a more experienced person.

Click on the coloured tabs in turn to specify the records you want to use, 
and arrange the fields, labels, titles, etc on the Layout as you wish. 
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Step-by-Step report Design
As you complete one step, it sets up parameters (eg. a list of Fields) that you 
can use in a later step.

1. SETUP Tab: Give the report a Title, and optionally add some note to 
describe this report and what it will show (this note does not print).

2. SELECT DATA: Choose a database (Accounts or Filing). 
Specify which File (Table) to use. For the simplest report, just click on 
one of the displayed File names. If you are more experienced you can 
enter a SQL expression (the SELECT clause) to link (join) more than 
one Table together.

3. SELECT DATA: Choose which records to use. If you tick the USE ALL 
RECORDS box, all records will be included. Filters are created by 
using a SQL expression, and ABC includes a Wizard to make this 
a little easier.  You can even set the report to ask the user to enter a 
parameter at the time the report is run.  (simple books on SQL are 
available, or you can ask your support company or ABC Software to 
assist in designing a report).

4. SELECT DATA: Specify a field to Sort the records on, and choose 
ascending or descending order.  If you wish your records grouped 
(sub-divided) choose a field to Group on. (If using Groups, you can 
print sub-totals for each group if you wish).

5. LAYOUT: click on the toolbar to add some fields to your report 
layout. You can also add text labels to describe a field, pictures, and 
calculated fields. Drag these items to move or resize them as you 
wish. There are three sections where you can add text -- the Column 
Headers (top of each page), Main Body of the report, and Report 
Footer (prints at end of the report -- here you might put totals).

6. LAYOUT: You can format items by right-clicking the item and select 
Properties. Change the font, text size, colour, etc. With calculated 
fields you can enter a calculation. To delete an item from the layout, 
right-click and select Remove.

7. LAYOUT: To align items, first Shift-Click on the items (a red box will 
appear showing they are selected) and then right-click on one and 
choose an alignment option.

8. LAYOUT: Totals Several types of totalling operations can be carried out 
-- Count, Average, Sum.  Right-click on a field and select Properties to 
set up totals (up to 9 separate Totals can be used). In the report Footer 
specify which Total(s) you wish to print.

9. Options Menu (toolbar at top of the report window) allows you to 
choose whether to print separator lines between records, show page 
numbers, set page to be portrait or landscape, etc. If you have used 
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Groups then you can choose whether to print all the detail lines for 
each Group, or just a summary.

10. Remember to SAVE your report before trying it.

11. The TEST button will show how many records your current filter will 
show (If it seems the filter is having no effect, check you have not 
ticked the Show All box which will cancel any filter).

12. Click PREVIEW to see what your report looks like. If anything needs 
changing, go back and alter it. Trial and error is the technique.

Save the Report
From the toolbar at the top, select Save or Save As. (Save will overwrite the 
existing version of this report -- even if you’ve changed its title --  but SAVE 
AS will create a separate copy of the report that you can edit to change 
some features).

Report designs are stored in a file called ReportLayouts.mdb located in the  \
ABC6\GENDATA folder. Even if you have several Companies set up in ABC, 
these reports will work with whichever company you are currently using.

Delete the Report
From the toolbar at the top, select Delete. (The report must already be 
loaded in order to Delete it).

Preview or Print the Report
Click the PREVIEW button. This displays the finished report in the report 
viewer, and the toolbar at the top provides functions for printing to paper, 
or exporting to PDF or HTML file.

88	 |	 ABC6 User Manual



Label printing
The label function is intended for producing address labels for mailings to 
your Customers or Suppliers, onto A4 size sheets of labels (eg Avery). .

Filing  > Label Printing
From the toolbar choose LOAD (an existing label) or NEW (create your 
own). Beginners can simply Load and Print a label design that may have 
been created by a more experienced person.

Click on the coloured tabs in turn to specify the records you want to use, 
and arrange the fields, labels, titles, etc on the Layout as you wish. 

LABEL SETUP:  Set the number of copies of each label to print.

To  specify the size and layout of the labels you can select one of the AVERY 
label codes, or set the number of labels down and across a sheet yourself. 
When you change the label size, the Layout area is set to this size. 

If the Start at Label 1 box is not ticked, ABC shows a representation of a 
sheet of labels, and you can tick the position you wish the first page to start 
printing (this is useful if you have a part-used sheet of labels).

SELECT DATA: This is identical to the section Select Data for Report 
Printing -- page 87.
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LAYOUT: You can make addresses look neater by ticking the box Tidy 
Addresses -- ABC will then try to remove blank lines in an address.

Tick the SHOW RETURN ADDRESS box if you want your own return 
address printed on the label. A separate tab page lets you define the address 
and set the colour for the text.  Click the Company Address button to fill 
your own Company Address into the return Address fields, but you can edit 
this test as required.

Save the Label
From the toolbar at the top, select Save or Save As. (Save will overwrite the 
existing version of this label -- even if you’ve changed its title --  but SAVE 
AS will create a separate copy of the label.)

Report designs are stored in a file called LabelLayouts.mdb located in the  \
ABC6\GENDATA folder. Even if you have several Companies set up in ABC, 
these labels will work with whichever company you are currently using.

Delete the Label
From the toolbar at the top, select Delete. (The label must already be loaded 
in order to Delete it).

Preview or Print the Label
The TEST button will show how many records will be used for this label 
print. (If your filter does not seem to be working, check you have not got the 
USE ALL RECORDS box ticked). 

Click the PREVIEW button. This displays the labels in the report viewer, 
and the toolbar at the top provides functions for printing to paper, or 
exporting to PDF or HTML file.

If the printer messes up part of the printout the report 
Viewer does allow you to select just a range of pages for 
reprinting. 
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9
TYPING

Edit Text, Print Letters, 
 Mail Merge

You can select TYPING from the Main Menu and use it as a simple 
wordprocessor (with MailMerge capability).  And in various other parts 
of ABC you can select Print A Letter and this same “Typing” function will 
appear  -- for example, while looking at a Customer Record you can produce 
a letter to the Customer.

Edit text

Change text size, colour or font.
Highlight a section of text and then choose a function from the toolbar at 
the top of the window.

If no text is highlighted, any changes you make will apply to all new text 
that you enter from now on.

To select ALL text, press CTRL+A

Ruler, Margins, Tab stops
The ruler across the top of the text shows left and right margins, indent, 
and any tab stops. These can all be set differently for each paragraph.

Click on a paragraph to make it into the current paragraph, and then drag 
the little triangular markers along the ruler to change the margins. The 
marker on the top of the ruler sets an indent (or outdent) for the first line of 
the paragraph.

Alternatively, right click the mouse on the ruler and a form will appear that 
allows you to set margins and tabs for the paragraph.

If you want to change several paragraphs at the same time, highlight them 
first.  (CTRL+A will select All Text)
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Graphics (pictures)
You can insert pictures into the text. Position the cursor at the bottom left of 
where you require the picture, and from the Options Menu select INSERT 
GRAPHIC. Choose any picture file (eg. .BMP) and it will appear on screen. 

You can click the picture and then resize it by dragging the corners or 
sides. You can also move it to a different position, but note that the picture 
is treated like a big word -- it must be inserted into the text (it does not 
overlap any text). As you drag a picture, a small line cursor shows where it 
will be inserted when you release the mouse button. 

Word Count
From the Options Menu select Word Count, and ABC will display the 
number of words in this document. 

Find and Replace
Select FIND from the Edit Menu.  

Spell Check
From the Options Menu you can choose AUTO SPELL and ABC will then 
check your spelling as you type and underline any suspect words with a red 
wavy line.

If you right click on a suspect word, you can select from several spell check 
options:     

Ignore All -- tell the Spell Checker that this word is OK.     

Add  --  tell the Spell Checker to add this word to the Dictionary.
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Spelling -- ABC will display suggestions for the correct spelling of                       
this word. Sometimes these will be sensible.... 

To check through all the words in the document, select Spell Check from 
the Options Menu. ABC will display each suspect word in turn, with 
suggestions for its replacement.

Headers, Footers
A Header (or Footer) is a separate text file that ABC can automatically insert 
at the top (or bottom) of every page. This can include pictures or calculated 
fields such as today’s date or page number. ABC allows you to specify 
which pages the Header should appear on (for example, even pages only).

You should first create Header(s) and Footer(s) as separate documents. Then 
these can be loaded into any other document while editing it. From the 
Options Menu select Header & Footers.

The background colour of Headers and Footers can be set, along with their 
width, height and other properties.

Mail-merge
When printing letters or notes on paper, you can get ABC to automatically 
fill names and addresses or other information into the text. This is known 
as mail-merge. The data being inserted can come from any Record Card.

The MailMerge function can be turned On or Off. From the Options Menu 
select Allow MailMerge. Then click the MAILMERGE button and a new 
area with several tabs will appear at the top of the Typing window.
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First select which File to use, from the File tab The other tabs allow you to 
specify which Records to use, and which Fields to use in your letter.. 

Specify a MailMerge Field in your letter
The easiest method is to click on a Field Name in the drop down list on 
the Fields tab, then click at the position in the letter you want to insert this 
Field, and type CTRL +V.   This will paste the Field into your letter. 

Preview while editing
Click the Preview tab and ABC will merge data from the first Record into 
your letter. You can use the Previous < and Next > buttons to try different 
Records and ensure everything is working as expected.  Close this Preview 
before you can resume editing the letter.

Choose a group of Records
On the RECORDS tab you can specify criteria to choose a group of Records. 

Here are some examples (using the Customer File). When you EDIT a 
selection criteria and then SAVE. a line just above the tabs indicates how 
many records match the criteria.

    a) To select records where address line 4 is in London: 
          >>   WHERE custADDR4 = ‘London’     (Note the single quotes reqd)

b) To use all records.  >>   ALL

c) To use Records where Account Number is between 50 and 100  
   >>   WHERE custACCT > 49 AND custACCT < 101

The selection criteria you enter are using the SQL language. See page 112 . 
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10
Spread Sheet

The ABC SpreadSheet is relatively simple, but it has the useful feature of 
Formulae to call data out of ABC Account Files, for example for CashFlow 
Forecasts. You can enhance your SpreadSheets by using different sizes 
and colours of text, and inserting pictures into cells. Approximately 500 
columns by 500 rows can be used. 

Spreadsheets can be imported and exported in various formats including 
MS Excel, HTML, and text files.

Edit Numbers or Text cells
Click on a cell, and just start typing. Enter a number or some text. The 
Options Menu allows you to choose what happens when you first select a 
cell -- whether to highlight all existing text or not. 

Simply move out of the cell when you’ve finished Editing. Press the TAB 
key to move to the next cell, or ENTER to move down a cell.

Caution.  It is easy to confuse yourself if you press 
ENTER while editing a cell which allows multi lines. In 
this case ENTER will simply move you to the next line 
within the cell (and probably scroll the first line out of 
sight so you are left wondering what has happened).

Insert or Delete a Column or Row
Position the cursor first, and then from the Edit Menu at the top, select the 
required operation.

Any formulae involved will be automatically adjusted. 

Types of cell
Each cell can contain text, numbers, a formula, or a picture. Right click on 
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a cell and choose the type of cell you require from the pop down list. The 
default cell type is Any Text.

Type of cell  Description

Any Text Whatever you enter here is treated as text.

Currency This is a number that is formatted to two 
decimal places with a currency symbol.

Number Any number.

Percent Displays percentages to two decimal places 
and followed by a % sign.

Formula This is not a separate cell type. It just provides 
a reminder that you must first set the cell Type 
to Currency, Number, or Percentage  -- these 
are the only cell Types in which you can enter 
a Formula.

Formula
You can enter a Formula into any numeric type cell (so you may need to 
first set the type of cell as Currency, Number, or Percent).

Position the cursor on a cell and press “=”. You can then enter a Formula 
for that cell, or edit the existing Formula.

Each Formula can can include

   positions (eg. A21, G4 )   
   numbers (eg. 1.15, 32)  
   operators (eg. +  / * ^ ) 
       Where * means multiply, and / means divide by 
                 ^ means to the power of

You can also use brackets: eg A2 * (A1 + 57.5)

Examples:
A3 + B17 This will add the number at position A3 and the number at 

position B17. 

C5 + (C6 + B4) * 1.15 Add number in cell C5 to 1.15 times the sum of 
the numbers at C6 and B4.

Keywords (functions) can be used in Formula. For example, words like 
AVERAGE, SUM, TAN, DATE, TODAY, MIN, MAX.

Examples:

sum(A3:A17)  add up the Range of cells between A3 and A17 
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max(B4:F4)  use the maximum value in the range B4 to F4 

average(A3:A99)  use the average value of the range A3 to A99

In most of these Formulae, blank (unused) cells are ignored (ie. not 
included in average, etc)

Link to Nominal Ledger (Headings)
Information from any Heading (Nominal account) can be used within a 
Formula. The current information from the Headings File is inserted into 
the Sheet.

Use the special formula hdg to indicate you wish to use figures from the 
Headings File, and follow this with a word to specify whether you want 
the Current Balance, Last Year (opening balance), Month to Date, or Budget 
figure; and give the Heading number that you require.

Examples:

hdgBUDGET(3351)   --  The Budget figure for Heading 3351 

hdgCURR(8411)    -- The current balance of Heading 8411 

hdgMTD(1111)   --  The Month to Date figure for Heading 1111

hdgOBAL(4211)  --  The opening Balance figure for Heading 4211

Other Formulae
A vast range of other functions (keywords) and operators can be used in 
Formulae. For help with Formula, press F1 while using the SpreadSheet.

We can add custom Formulae to the ABC SpreadSheet, so contact us if you 
need anything specific to your trade or business.

Copy or Move or Clear a cell or block of cells
You can use the mouse to highlight a cell or block of cells, and then 
position the mouse at the edge of the highlight (so the cursor shape 
changes) and drag the highlighted area somewhere else. This will MOVE 
the original cells. If you press SHIFT while dragging, you make a COPY 
of the original.  While the cells are highlighted, the Edit Menu gives other 
options -- eg, Clear the selected cells.

This drag and drop operation can be turned On or Off on the Edit Menu.

Adjust Column width and Row height
You can change the size of the cells by dragging the cell bottom edge, and/or 
right hand edge, at the grey row or column title area.
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Pictures in cells
Position the cursor on a cell, and then select INSERT PICTURE from the 
Edit Menu at the top.  You can then browse to select a picture to insert into 
the cell.  The picture will be resized to fit the size of the cell, but the full 
sized picture will be stored internally. We recommend you only use small 
picture files (eg. file size less than 20K) for inserting into the SpreadSheet. 
Larger pictures should first be resized using a paint package.

Change the size of the picture by dragging the cell width and height (see 
above).

Freeze/Release titles
It is sometimes useful to keep the Column and Row titles fixed while the 
rest of the sheet scrolls. From the Options Menu at the top of the Sheet, 
select the choice you require.

Print on Paper
The entire Sheet will be printed out on your printer. Because the Sheet 
can be larger than the paper, it will be printed in sections (you can set the 
printer to landscape format if you wish). Use the Print Preview and you can 
set up Header and Footer, page size, etc.

Import/Export
You can import your old spreadsheets from ABC5. You can import data 
in various other formats, including text files and Excel sheets. There is 
a function to import your customers, suppliers, or stock records to the 
spreadsheet (editing the spreadsheet will not affect the original accounts 
files).

It is also possible to export data in several ways including Excel, text file, 
HTML and XML.

From the File Menu at the top, select Export or Import, and then choose the 
required function.

Expect to do some fine tuning on imported data as other software may have 
slightly different features compared to ABC6.
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11
Useful extras

Calculator,  Notes, 
Envelope Printer 
Calendar/Diary

This chapter describes the very useful functions that you can use at almost 
any time, no matter what you are doing. They can be accessed from the 
Quick Access Toolbar at the top of the screen, and you’ll also find them in 
various places throughout ABC.

This type of accessory was very useful in 
early versions of ABC running under DOS 
but these days Windows provides much 
of this functionality already.  However 
accessories that link directly to parts of 
ABC are retained because they provide 
unique and useful function.

Noticeboard
When you startup ABC, the Noticeboard can be shown on the screen 
(or it can be turned off). Use the OPTIONS Menu (top right of screen) to 
change this setting. The Noticeboard is a useful place to leave a message for 
yourself or the next person to use the computer. 

Calculator
This function allows you to use your expensive computer as a cheap 
calculator. Some useful functions are included for quick calculations or 
adding up a stack of petrol receipts. For example, to add or remove VAT 
from the figure you enter.

You can type on the keyboard or use the mouse to click the buttons on 
screen. 
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Print Envelope
The first tab page allows you to select envelope size, and choose whether to 
have your return address printed top left, and an optional small picture or 
company logo.

It is usually best to allow ABC to TIDY THE ADDRESS -- this means that 
any blank lines in the middle of the address will be removed and the 
remaining lines moved up.  It makes the address look neater.

If you have called Envelope Print while looking at a Customer or Supplier 
Record Card, then that company’s address should automatically have been 
filled into the name and address boxes on the Text tab page. You can edit 
these details or type a new address.

You may need to experiment with your particular printer to see which way 
round to insert envelopes.

Yellow Notes
Most screens in ABC have a yellow button marked NOTES. This is for your 
own use. View or edit a note about that ABC function. An experienced user 
could leave hints for the newcomer.

Diary/Calendar
The Dairy/Calendar is a versatile and powerful tool for organising your 
appointments and reminders. You can colour code events and set alarms 
to remind at specified time prior to start (and there is a five minute snooze 
button).

Items can be set to automatically repeat every week, month or 
year (ideal for remembering birthdays or anniversaries). The 
Diary can be viewed in many different ways: eg. one day, one 
week, or a month at a time. any view can be printed on paper.

The diary can be set to automatically appear when you start 
ABC (use the OPTIONS Menu top right of screen to set this). 
The Diary will automatically auto-hide itself at the right hand 
edge of the screen. Just move the mouse over the little Diary 
Tab to make it slide open.

Operation of the diary should be quite intuitive. Right 
click on a Diary page and select New Event to create a new 
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appointment, or simply double click on a page. You can then fill in details 
of the appointment (event). If you click on an existing event you can edit it.

You can cut and paste or drag appointments to another time or day.

The Diary will normally automatically hide when you move the mouse 
away from it, but you can also click the blue down-arrow to hide the Diary, 
or click the green cross to close the Diary.

If you have closed the Diary, you can open 
it again any time by clicking the icon on the 
Quick Access toolbar (top left of screen). And 
if that icon is not visible, click the little down 
arrow at the right of the QA toolbar and tick 
the DIARY option. (this is a reminder that the 
QA toolbar can be customised to remove or 
add more items as you require).
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Email
You can send an email to us here at ABC Control Tower using the 
Tools Menu (top right of screen) and select  EMAIL TO ABC. This will 
automatically add your ABC package number and version number to the 
bottom of the email. Use this to make suggestions for new features or report 
a bug.

With Sales Invoices and Statements you can now email them to customers 
instead of printing on paper. For this to work you must enter each 
customer’s email address onto their Record Card. Produce the invoice or 
statement in the usual way, and then in the Report Viewer select EMAIL 
instead of selecting PRINT.

ABC offers two different ways of sending emails. The best method is MAPI 
(which uses your own email system that is already set up on your computer 
-- if you have more than one, the default one will be used). With MAPI there 
is no need to set anything up in ABC (ignore the fields for Password etc).

In rare cases, if MAPI does not work for you, try ABC’s own simple email 
system. The first time you use the ABC email function you will need to 
enter the details of your ISP MailServer and your UserName and Password. 
If you don’t have this information to hand, contact your ISP.

The ABC email software does not add 
copies of emails to your usual email 
program, which is a disadvantage. That’s 
why it is better to use MAPI if possible. 
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 12
Backup

Backups and Snapshots

Backups and Snapshots sound similar but have different purposes: They 
can be selected from several places in ABC, and before doing anything 
“dangerous” (eg. MonthEnd) ABC will suggest making a Snapshot first.

When you exit from ABC, if you have not made a backup recently ABC will 
prompt you to do so now. You can turn this prompt off if you must -- but we 
strongly suggest you DO backup regularly.

Backups
Every hard disk will stop working sometime; maybe in 5 years, maybe 
tomorrow. To protect yourself against this, you must make copies of your 
information onto removable storage; these are your backup copies. Possibly 
the best method is to backup onto RAM drives (USB memory sticks) that 
simply plug into your computer. Second best method is CD or DVD. Other 
methods are available.

To protect against your premises catching fire, or theft, you should keep 
these backups in a separate building. To protect against faults that may 
be undetected for a few weeks, you need several different backup sets. 
Remember that backups contain all your business information, so keep 
them in a secure place.

Snapshots
Snapshots allow you to quickly make a copy of your Accounts information 
onto another folder on your hard disk. You can keep up to ten different 
Snapshots.

Because the Snapshots are held on your hard disk, it is very fast and 
convenient to use. But it does not protect you against hard disk failure or 
fire/theft -- so you also need regular separate Backups.

Create a Snapshot
ABC will display all existing Snapshots. Select one of the ten Snapshots 
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Positions to be used.  You can write to a blank (empty) position or overwrite 
an existing Snapshot.

Snapshots are automatically labelled with the date and time that they were 
created, and you should also enter a note to describe this Snapshot.

Restore a Snapshot
This function will copy the Snapshot accounts files back into your real 
accounts -- this overwrites the existing current accounts. 

ABC will display all the existing Snapshots. Select one of the available 
Snapshots to use. Do not proceed unless you are sure you want to replace 
your existing accounts with the Snapshot copy.

Other companies
The Snapshot and Backup functions operate on the current company you 
are working on. If you have set up several companies in ABC, you must 
Backup each separately.

Create a Backup
Plug the removeable device (eg USB stick) into the computer (or ensure 
there is a blank CD in the drive) before you select the Backup function, 
because ABC starts by scanning all drives attached to the computer and 
only lists those it can write to.

Select which drive to Backup onto (this could be a network drive). The 
Backup will be stored in a folder labelled with the date and time. This 
means you can keep many different backups on the same external drive or 
memory stick.

Everything gets backed up (files, text, spreadsheets, etc).

Restore a Backup
ABC checks all drives attached to the computer and displays the suitable 
Backups that are found. You can select one of these to restore. 

You can also choose which items to restore, eg text, account files, etc.

In earlier versions of ABC6 the Backup function was 
simpler and shared the screen with Snapshots.  
The new Backup is a separate more powerful function 
that cannot read the old backups. 
So we have left the old Backup’s Restore function on 
the Snapshot page in case you need an old backup. .
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 13
Installation

How to install ABC onto your computer. 
 How to update your programs.

ABC will run on any computer which is PC compatible and has Windows 
NT, XP, Vista or Windows 7, 8 or 10.

 

Installation
Place the CD into your CD drive. Use MyComputer, and “browse” to the CD 
drive (often this will be drive D) to view the contents of the CD.

Double click on the installation program to run it.  
Typically this will be called SETUP  or  ABC6 INSTALL.

Follow the instructions on the screen.  
(NETWORK version? See separate ABC Network Manual)

Version number
To see the Version Number and date of your ABC programs, select the Tools 
Menu (top right of the screen) and then SHOW VERSION. If you are ringing 
up for help, it is one of the things we will ask you for.

If your programs are over 3 months old, we strongly recommend you obtain 
an Update, either from our website www.ABC6.co.uk or contact us for a 
disk. The latest programs will have many enhancements and improvements 
(suggested by users of ABC); and of course any reported bugs will have 
been fixed.
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Registration Key
Although you can begin fully using ABC immediately after purchasing it, 
you need to Register the package within a few weeks. Do this by entering 
your Registration Key and Serial Number. 
     Tools Menu (top right of screen) > Register.

The Registration Key is normally supplied with the package, but can be 
obtained from ABC Direct Sales (page iv) if you can’t find it. If you have the 
ABC package on 30 day Sale or Return, or a Trial version from the website, 
we do not supply the Registration Key until you have paid for the package. 
ABC will work happily without this key for a couple of months, so there is 
no urgency.

There is an option to print out your Company Name and address on 
paper. We recommend you post or email these details to ABC Software so 
we can add you to our mailing list (these details will not be released to 
anyone else).  With an accounts package it is particularly important that 
we can notify you if accounting or VAT rules change, or bugs are found 
and important updates become available. We will not give your details to 

anyone else.

Program updates 
An UPDATE contains the latest version of the programs.  We are tirelessly 
working to fix bugs and enhance the features of ABC. Updates are brought 
out every week or two. These can be downloaded from our website, or for a 
small charge we will post you an Update CD. 

Automatic Updates
We recommend you set ABC to automatically update itself from our website 
(See Tools Menu, top right of screen -- tick AUTO-UPDATE). Each time you 
start ABC it will check the website for new software, and offer to update 
itself -- this typically only takes a few seconds.

Updates are provided free while your After Sales Support is valid.  
If you do not have Support but want an update, you can pay a few pounds 
on our website for one month’s Support (allows you to download updates 
for a month), or contact us and for a similar amount we will  post you the 
latest Update CD.  Support includes telephone help.

User Forum
There is a free User Forum on our website where you can read comments 
and questions/answers from other ABC users. Only registered users of ABC 
are able to write messages on the Forum, but any casual visitor can read 
them. You can get to the Forum using the Tools Menu (top right of screen).
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Reference
How to operate ABC:  

the common functions

Select a Date
Enter a date in the format DD MMM YYYY  
 (eg. 23 Jun 2014)    Shortcuts are acceptable, 
 such as 23 jun 14,  6/23/14

To use a popup Calendar either click on the button 
or press F8. You can then select a date by clicking 
on the Calendar. The buttons at the top move to 
previous or next month. 

ABC will sometimes restrict the range of dates 
you can enter -- for example you can’t add new 
transactions to a previous month’s accounts. 
Typically the date entry will turn red to show the 
date is not acceptable  -- try a different date.

Select a Heading
You can enter a valid Heading Code (eg 1121) if you know it, or leave it 
blank (or press the little button) to see a popup list of Headings to choose 
from. 

You can cursor up/down, use PageUp/Down, or use the mouse to scroll up 
or down. Click on the column titles of this list to sort the list.

Select a Heading by clicking on it, or press ENTER.

ABC may restrict the Headings on the list to only show those that are 
suitable for the current task. eg if you are selecting a bank account, only the 
Bank Headings will be displayed.
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Select a Payment Method
Enter a code for the payment method (eg. CQ for Cheque) or leave blank (or 
click the little button) to see a list to choose from.

ABC may only display methods applicable to the current task. 

 

The Payment Method and Payment Heading 
Code may affect each other. For example, if 
you are making a payment in cash, methods 
like Direct Debit or Credit Card will not be 
displayed.

Select a VAT Code
Enter a code for the VAT rate applicable 
to this transaction (eg. 1 = standard rate). 
Leave blank (or click the button) for a list 
of VAT Codes to choose from.

Move the mouse of the HINT column to 
see a tooltip giving advice about each line. 
These “hints” can be customised by you 
-- page 21.

Enter amount of VAT
In many places ABC can calculate the amount of VAT for you. For example 
in the CashBook, after you have entered the total amount and the VAT code, 
you can press F8 (or click the down arrow) and ABC will calculate and fill-
in the VAT Amount for you.  You can edit this if you wish.
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Find a Record
There will be many occasions when you need to find a Record Card, for 
example select a Customer Record in order to invoice them. 
The Find panel appears at the left of the Record Card, and shows a list of 
records. Click a record to  select it.

Click a column header (in 
this example, Acct, Key, 
or Company) to sort the 
list into that order (click 
again to reverse order the 
sort). 

You can apply a filter 
to select just a group 
of matching records by 
entering some text in the 
box. The list will then 
only show matching 
records. Click the SHOW-
ALL button to cancel the 
filter and display all the 
records again.

There are vcr type 
buttons under the list, 
allowing you to jump to 
the Next, Previous, First 
or Last records -- These 
relate to the current 
sequence determined by 
Sorting and filtering. 

When looking at Customer or Supplier Records, you could also find a 
record by entering an invoice number (eg. SL4563, or PL280911) or the 
account number (eg. #34, or #481).  The prefix # or SL must be entered. 
If you tick the ONLY SHOW UNPAID box, only customers/suppliers with 
outstanding invoices will be shown. And you can mark records as Inactive, 
and a button on the ribbonbar allows you to Hide/Show the Inactive 
records.
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Apply a Filter to select Records
At various times you will want to filter the Records, for example for a 
Report or Label print, or for Global Change.

SQL -- a brief introduction
ABC uses SQL for selecting Records. SQL is a programming language that 
databases understand. It can be easier than you think to make simple 
selection requests (queries). For example, to request customer records where 
the account number is greater than 50 and less than 300, and the 3rd line of 
the address is the word “London”, the SQL expression would be:

   WHERE custACCT > 50 AND custACCT < 300   AND   custADDR3 = ‘London’ 

If you have a particular requirement for filtering records, you can ask your 
Support Company (or ABC Direct Sales) to tell you what to type in.  Experts 
will probably be familiar with simple SQL queries, and many books are 
available.

ABC has a SQL Wizard that can assist in creating SQL expressions. Experts 
can then edit the results for further fine tuning.

Edit a Record Card 
Whenever there is a Record Card on the screen, there will usually be 
buttons on the ribbonBar which include the options.

EDIT allows you to change (alter, change) the information in that Record 
Card. 

ADD will create a new (blank) Record Card for you to edit.

When you select EDIT (or ADD), the screen will appear with the cursor 
flashing in one of the Fields. You can now edit that Field.

Editing a Field is similar to editing text. You can type over any information 
in the Field; or use CURSOR LEFT or CURSOR RIGHT to move left or 
right. To Delete one character, use the BACKSPACE or DEL key. To switch 
between insert and overtype mode, press the INS key.

If you change your mind, press ESC to UNDO any changes.

Experts may get frustrated by having to 
click EDIT in ABC before they can change 
anything. This feature can be turned off so 
you do not need to click EDIT first.  
Accounts Utilities > Edit Company Params.
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Move to another Field
When you have finished editing a Field, press ENTER. Or use CURSOR UP/
DOWN to move to another Field.    (of course you can also use the TAB key 
to move between Fields,  or simply click in a Field with the mouse).

Finish editing the Record
If everything is correct, click SAVE. If you want 
cancel the changes, click CANCEL.

You can click a button with the mouse, but it may 
be faster to press ALT-S to Save, ALT-C to Cancel 
(old ABC users can still use F5 to SAVE, and ESC to 
cancel).
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A Grid (ie. Table) of data
The versatile grid is used throughout ABC for viewing and editing data, like 
the example below.

If you view your Customer Records in a grid, each row is one Record, and 
each column displays a Field. You can customise most grids by swapping 
columns around and changing their widths, sorting into different order, 
creating groups of records, as described below:

Click the mouse to select a row (it then becomes highlighted), or use the 
cursor keys to move the highlight up or down. The highlighted row is called 
the Current Row.

Move or Size columns
Use the mouse to drag a column title to a new position and drop it there 
-- the column will then move to that position. If you drag the dividing line 
between column titles, you can stretch a column bigger or smaller.

Print part of the Grid
If you highlight a few lines in the grid, you usually will find a menu choice 
to print those lines on paper (eg. File Menu > Print Selected). To select ALL 
the rows in the grid, press CTRL +A.
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Edit the Grid
Some grids can be treated like a spreadsheet -- you can click anywhere 
and simply edit what you like. Others may only let you edit one line at a 
time -- normally you can double-click on a line (or press ENTER when it is 
highlighted) to begin editing.

Group records
You can group the records (rows) in the Grid together to make it easier to 
find things or spot trends. Simply drag a column title into the area above 
the grid, and the records will be grouped based on that column. If you want 
a sub-group, you can then also drag another column title into the area.

To cancel grouping of records, drag the column title out of the area above 
the grid and drop it back on the grid.

This temporary grouping function is just for viewing records on screen. It 
does not affect the actual order of records in the file.

Sort the Grid
Usually you can simply click on a column title to cause the Grid to resort 
itself in that order -- click on it again to sort in reverse order.

Some grids can not be changed in this 
way. Some grids will remember the 
changes you make and stay like this 
until you change them again. 
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Features of ABC reports
Page 112 illustrates many features of the ABC bookkeeping reports.

1 -- The Report Viewer Toolbar -- see next page for details.

2 -- The cursor. If you hold down the left mouse button and drag the 
cursor, the report also moves. This is a quick way to scroll up, down, 
left or right.  Or you can use the cursor keys.

3 -- Your Company Name at the top of every report (page 77)

4 -- Your company logo (or any small picture you provide).  
Or no picture at all.      (page 77).

5 -- The report title describes this report and includes a note of any range 
of values used; also shows if this is a Month End final report.

6 -- The current Date and Time are printed at the top of each report. This 
shows when the report was printed; it does not refer to the contents 
of the report.

7 -- The page number.

8 -- The body of the report.

9 -- The end of the report usually shows a summary of Nominal Ledger 
movements (Heading Analysis)

10 -- A summary of the VAT may be shown at the end of a report.

11 -- To explain abbreviations used in a report, a key is printed at the end 
of some reports.

12 -- While printing some bookkeeping reports, ABC can cross-check 
the integrity of the data. This is shown at the end of the report in the 
DATA CHECK.  
                          r for OK,    or t if a problem was detected          
                                                            (with brief note of the error).

13 -- Some reports include an optional Table of Contents. If you click 
on an entry in this Table, the report jumps straight to the page 
containing that entry -- very useful if there are many pages. You can 
hide or show the Table of Contents.
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The Report Viewer Toolbar
This appears at the top of the report Preview, and provides functions to 
change page, zoom in or out, hide or display the Table of Contents, and 
send the report to a printer or fax modem. There is an option to Email the 
report, and to export to disk file as PDF, HTML, or text. You can click the 
buttons, or use the keyboard (eg. ALT-P to select Print, the Plus/Minus keys 
to zoom, PgUp/PgDn keys to change page).

xx Table of Contents -- the first (left) button allows you to hide or 
display the Contents. (Not all reports have a Table of Contents). 
Click on an entry in the TOC to jump to that page.

xx Export will create a disk file in your choice of HTML, PDF, or CSV 
TEXT format.

xx Email allows you to send this report by email.

xx Print -- Allows you to select a printer, and range of pages to print.

xx Zoom size slider -- Change the display size on screen.

xx Buttons allow you to jump to First or Last, Next or Previous page.

xx Report pages -- Shows the current page, and total pages (eg. 1/3 
indicates you are on page 1 of a 3 page report).

xx Help -- Displays the on-screen User Manual section showing how to 
use the report viewer, with general hints and tips.

xx Close -- (green X) Close the report viewer (exit from the report). You 
can also close a report by pressing the ESC key.

For Sales Invoices and Statements 
an additional TEXT-PRINT button 
will appear. This allows you to send 
text-only printing (eg for a dot-matrix 
printer) using your own layout. 
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Glossary

Technical words explained

ACCOUNT A card containing a Customers Name, Address and other 
details is called a Customer Record Card by computer 
people; but a bookkeeper will call it the Customer Account. 
You can choose which you prefer.

ALLOCATE In ABC you mark an Invoice as “paid” by allocating a 
money payment (or a Credit Note) against it.

BALANCE The current total of an account (record card). eg. The 
amount a customer owes you is called their balance.

CASH not Credit. Can include cheques, Direct Debits, coins, bank 
transfers, etc. But no invoice or deferred payment.

COLUMN See FILE. In a Table, Columns are the Fields of Records.

CREDIT An item is not paid for immediately, but is obtained on 
credit. ie. not cash

DATA Any information (such as a name and address, or a letter) 
can be made to sound more important by calling it data. 

DATABASE 
(.MDB)

ABC stores data on disk in MDB files, using the MS JET 
engine (like Access).  We define a Database in this context 
as a huge diskfile that contains all of the various ABC 
accounts information. Inside the Database we can think of 
the data as being stored in separate Files or Tables. ABC 
also has several other databases, for example one stores all 
the Files you create with FILING.

DEFAULT The suggested normal option. To make life easier for you 
the computer will often display a default entry (eg. today’s 
date) which you can accept or change.

DIRECTORY See SUB-DIRECTORY (Also called a Folder).
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FILE RECORD 
and FIELD and 
TABLE)

The Customer File contains a Record Card for each 
customer. Each card stores details of their Name Address 
Telephone etc -- and these boxes are called fields; eg. the 
Postcode Field.  (more recently people have started calling 
Files Tables -- eg. the Customer Table, and the Fields are 
Columns in the Table).  You enter information into Fields 
on the screen (or Columns in a Table/Grid)

FOLDER Another word for a subdirectory or an area of the disk.

PATH A file Path is the full disk address leading to that file ie. 
starting from the main (or root) directory, down through 
all the sub-directories to reach that file. (see also SUB-
DIRECTORY)

POST Entering a transaction is sometimes called “posting” the 
transaction.

PROFORMA A quotation in the form of an invoice, showing the price, 
details, delivery, of the order. Not part of the accounts.

PROPERTY In computer terms the parameters (or option settings) of an 
item are sometimes called its “properties”. 

RECORD See FILE.  (in a Table you can think of a Record as one line 
or Row in the Table).

RIBBONBAR The multifunction toolbar across the top of the ABC 
window, which displays buttons and functions relevant to 
the task you have selected. 

SNAPSHOT A copy of the Account Files, frozen at the moment the 
Snapshot was made. Similar to Backup. See ARCHIVE.

SQL This stands for Structured Query Language and is the 
modern programming language for getting information in or 
out of a database. ABC uses SQL internally.

SUB-DIRECTORY Generally called a “Folder” these days. A small section of 
your hard disk. Instead of storing all files in one area, it 
makes life much easier if each program uses its own sub-
directory.

TABLE For many years we have used the word “File” to describe a 
collection of Records. However; in the database system that 
ABC now uses this collection of Records is called a “Table”. 

TRANSACTION When you buy something or sell something you are 
performing a transaction. Other transactions include paying 
wages to someone or taking money to the bank. 

UPDATE To bring something more up to date. For example to install a 
newer version of a program. 
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Trouble-shooting

Common Problems

Check the following before calling in the engineer.

Problem Possible Cause and Remedy

You have plugged in the 
computer system and 
switched on but nothing 
appears on the screen.

Check equipment switches are all 
ON. Check fuses in mains plug(s). If a 
fuse blows more than once don’t use 
equipment but call service engineer. 

Various strange symptoms Mysterious computer glitch; eg. power 
surge or loose connection. Switch off  
and check all connections, plugs and 
sockets are secure. Wait 1 minute before 
switching on again. 

Pressing a cursor key prints 
a number on screen, or 
unexpected capital letters.

You might have number lock or capitals 
lock selected. Press the NUM LOCK key 
or CAPS LOCK key to turn it off.

Screen display appears 
normal with flashing cursor 
but nothing happens when 
you press a key, or move the 
mouse.

Are you pressing an allowed key? Try 
pressing ESC.  
Keyboard may have become unplugged. 
Mouse may have become unplugged.

After switching on the 
computer it reports Invalid 
Boot disk or similar. Or 
computer freezes during 
startup.

Remove any disk from the floppy drive 
or CD drive. Switch everything OFF for 1 
minute and then try again. 

Customer or Supplier Record 
remains Locked (eg. after a 
crash or power cut)

Edit the Record and untick the “Locked” 
box
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Problem Possible Cause and Remedy

Reports or letters are OK in 
the on-screen Preview but 
nothing appears on paper 
when PRINT is selected.

Check the following: Printer (paper; 
ink; on-line); cables and connections; 
Open the Printer in Windows and check 
settings). If you are on a network; check 
the server and the PC with the printer 
connected. 

ABC won’t run, or you get an 
error message like “Cannot 
create server” or “Automation 
Error”, and the program stops.

If you are on a network ABC cannot run 
on Workstations unless it can access the 
data located on the server. Check the 
server and network. 
Update the software from our website: 
this usually fixes this type of error 
(caused by windows registry or file 
version confusion).

Main Menu button does not 
work. 

Use ALT-M to open the Main Menu (this 
also gets the button working again).

Program errors
We are confident you will not find anything serious wrong with the 
programs but it is likely there are minor errors (bugs) remaining. It is 
impossible to be certain that any complex computer program is free from 
bugs.

If you do suspect a problem of this type please make a careful note of what 
you were doing; what happened; what appeared on the screen; and then 
email us with those details.

UNLESS WE CAN REPRODUCE ANY FAULT YOU REPORT we cannot find 
it or fix it! So please:

a) check that you can reproduce any problem (Intermittent troubles; or 
symptoms that cannot be reproduced are usually due to the computer 
equipment or power supply. or interference from other software).

b) give us enough information so that we can follow the same path.

We do want to hear from you, and are very grateful for reports of any 
problems. We try to fix any bugs within 24 hours.

Updates containing the latest version of the programs are always available 
from the support people, on our website, or by post from us.

If your programs are a few months old and you find a problem, the first 
thing to try is getting the latest program update.
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List of Headings, print.  .   .   .   .     15
Logo

for top of reports .  .   .   .   .   .   .     77
on invoice.  .  .  .  .  .  .  .  .  .  .              60

Log On, or Log Off .  .   .   .   .   .   .   .    8

M
Mail-merge.  .   .   .   .   .   .   .   .   .   .     93

Print letter for customer .  .   .     29
Mail-Merge, customer.  .  .  .  .  .         67
Main Menu .  .  .  .  .  .  .  .  .  .  .  .             6
Margins, Typing.  .  .  .  .  .  .  .  .            91
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Markup
Stock calculation .  .  .  .  .  .  .          33

MDB database.  .  .  .  .  .  .  .  .  .             81
Method, select .  .   .   .   .   .   .   .   .   108
Mistakes.  .  .  .  .  .  .  .  .  .  .  .  .                10
Mistakes, correction .  .   .   .   .   .     40
Month End .  .   .   .   .   .   .   .   .     12, 73
Month, set accounts month.  .  .      18
Mouse, using.  .   .   .   .   .   .   .   .   .   .    3

N
Network ABC.  .  .  .  .  .  .  .  .            105
New Customer, add.  .  .  .  .  .  .          26
Nominal

Account.  .  .  .  .  .  .  .  .  .  .  .               25
Add new account.  .  .  .  .  .  .          30
Jounral entry (Transfer).  .  .  .       55
link to spreadsheet .  .  .  .  .  .         97
Transfers (direct entries) .  .  .      40

Nominal Ledger
Accounts .  .   .   .   .   .   .   .   .   .   .     15
Opening Balance.  .   .   .   .   .   .     54
Setting up.  .  .  .  .  .  .  .  .  .  .              15

Note, yellow.  .  .  .  .  .  .  .  .  .             100
Noticeboard.  .  .  .  .  .  .  .  .  .           8, 99

O
Opening Balance

Customer or Supplier.  .  .      19, 54
Nominal Ledger.  .  .  .  .  .         40, 54

Open Item
Customer Record .  .  .  .  .  .  .          28

Other Companies.  .  .  .  .  .  .  .           80
Overview of ABC.  .  .  .  .  .  .  .           76

P
Password .  .   .   .   .   .   .   .   .   .   .   .   .    8
Passwords.  .  .  .  .  .  .  .  .  .  .  .               78
Paste.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                 5
Pay money.  .  .  .  .  .  .  .  .  .  .  .               40
PDF, output .  .  .  .  .  .  .  .           65, 116
Petty Cash.  .  .  .  .  .  .  .  .  .             47, 51
Price Group, customer.  .   .   .   .     29
Print

Cheque .  .   .   .   .   .   .   .   .   .   .   .     48
Design your own labels.  .  .  .       87
Design your own report.  .  .  .       88
Envelope .  .   .   .   .   .   .   .   .   .   .   100

ProForma Invoice.  .  .  .  .  .  .  .           63
Program update.  .  .  .  .  .  .  .           106

Q
Quick Access toolbar.  .  .  .  .  .  .        9
Quick Access Toolbar.  .  .  .  .  .         99
Quotation .  .  .  .  .  .  .  .  .  .  .  .               64

R
Receive Money.  .   .   .   .   .   .   .   .     40
Reconcille bank.  .  .  .  .  .  .  .  .            54
Record

change properties.  .  .  .  .  .  .          82
How to Find.  .  .  .  .  .  .  .  .            109
Stock (Inventory) .  .  .  .  .  .  .          33

Record Card.  .  .  .  .  .  .  .  .  .  .              25
Nominal ledger .  .  .  .  .  .  .  .           30

Refund, from supplier .  .   .   .   .     50
Refund to customer.  .  .  .  .  .  .          44
Registration Key.  .  .  .  .  .  .          8, 106
Remittance Advice Note.  .   .   .     47
Report

Cashbook, Bank.  .  .  .  .  .  .  .           71
Design your own.  .   .   .   .   .   .     88
Features of ABC reports.  .  .      115
Logo for top of.  .  .  .  .  .  .  .  .            77
Nominal Ledger.  .  .  .  .  .  .  .           70
Output as HTML, PDF, CSV .    65
Sales, Customers.  .   .   .   .   .   .     66
Stock.  .  .  .  .  .  .  .  .  .  .  .  .  .   68
Supplier, Purchases.  .  .  .  .  .         67
VAT return .  .   .   .   .   .   .   .   .   .     70

S
Save or Cancel, Edit .  .   .   .   .   .   111
Screen colours .  .   .   .   .   .   .   .    9, 80
Set folio numbers.  .  .  .  .  .  .  .           18
Settlement Discount .  .   .   .   .   .     78

option on Customer record.  .     28
Snapshot .  .   .   .   .   .   .   .   .   .   .   .   103
Sort grid in order .  .  .  .  .  .  .          113
Spell Check, Typing.  .  .  .  .  .  .          92
SQL

select record in Typing .  .  .  .       94
SQL, select records.  .  .  .  .  .         110
Standing Orders.  .  .  .  .  .  .  .  .            52
Start using ABC.  .  .  .  .  .  .  .  .            13
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Stock
Delete record.  .   .   .   .   .   .   .   .     38
Goods IN or OUT.  .  .  .  .  .  .          57
Recalculate price.  .   .   .   .   .   34,37
Record card .  .  .  .  .  .  .  .  .  .             34
Text-only record.  .  .  .  .  .  .  .           34
Value.  .  .  .  .  .  .  .  .  .  .  .  .  .                 57

Supplier
Account.  .  .  .  .  .  .  .  .  .  .  .               25
add new.  .  .  .  .  .  .  .  .  .  .  .               19
Opening Balance.  .   .   .   .   .   .     54
Payment to .  .   .   .   .   .   .   .   .   .     47
Record Card.  .  .  .  .  .  .  .  .  .             25
Unpaid bill .  .   .   .   .   .   .   .   .   .     40

Support, After Sales .  .   .   .   .   .   .    2
Support, User Forum .  .  .  .  .        106

T
Table (grid) of data.  .   .   .   .   .   .   112
Terms

Customer Record .  .  .  .  .  .  .          29
Text-only stock record .  .   .   .   .     34
Tidy the address, envelope.  .     100
Transactions.  .  .  .  .  .  .  .  .  .  .              39
Transfers, N/L.  .  .  .  .  .  .  .           53, 55

U
Unit Cost, Stock.  .  .  .  .  .  .  .  .            36
Unpaid bill

mark paid .  .  .  .  .  .  .  .  .  .  .              47
Unpaid Bill .  .  .  .  .  .  .  .  .  .  .              40
Update, software.  .   .   .   .   .   .   .   106
Update Stock, unpaid bill .  .   .     59
USB sticks.  .  .  .  .  .  .  .  .  .  .              100
User Forum .  .  .  .  .  .  .  .  .            2, 106

V
Value, stock.  .  .  .  .  .  .  .  .  .  .              57
VAT

Cash Accounting.  .   .   .   .   .   .     22
codes .  .   .   .   .   .   .   .   .   .   .   .   .     21
Edit VAT rates.  .  .  .  .  .  .  .  .            21
Enter refund.  .  .  .  .  .  .  .  .  .             46
General notes .  .  .  .  .  .  .  .  .            22
Inclusive prices.  .  .  .  .  .  .  .           29
Invoice at zero VAT.  .  .  .  .  .         61
Notes for VAT inspector .  .   .     23
previous accounts.  .  .  .  .  .  .          19

Print return .  .  .  .  .  .  .  .  .  .             23
reports, Return .  .   .   .   .   .   .   .     70

VAT Code, enter.  .  .  .  .  .  .  .           108
VAT-inclusive Prices.  .   .   .   .   .     61
VAT-only Invoice .  .  .  .  .  .         59, 61
VAT Registration, set .  .  .  .  .  .         18
Version Number.  .  .  .  .  .  .  .           105

W
Wages .  .  .  .  .  .  .  .  .  .  .  .               52, 56
Write-off as discount .  .  .  .  .  .         42

X
Y
Year, accounting.  .  .  .  .  .  .  .  .            78
Year End.  .  .  .  .  .  .  .  .  .  .  .  .                75
Year, set accounts year.  .   .   .   .     18
Yellow Notes .  .   .   .   .   .   .   .   .   .   100

Z
Zero, invoice at zero VAT.  .  .  .       61
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